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About the
Documentation

This manual is part of a set of Fiery Network Controller for DocuColor 3535™

documentation that includes the following manuals for users and system

administrators:

The Quick Start Guide summarizes the steps for configuring the Fiery and printing.
It also describes how to access the online documentation.

The User Software Installation Guide describes how to install software from the
User Software CD to enable users to print to the Fiery, and also describes setting up
printing connections to the Fiery.

The Configuration Guide explains basic configuration and administration of the
Fiery for the supported platforms and network environments. It also includes

guidelines for setting up UNIX, Windows NT 4.0/2000, and Novell NetWare

servers to provide printing services to users.

The Printing Guide describes the printing features of the Fiery for users who send
jobs from their computers.

The Color Guide provides information on managing the color output of the Fiery.
It explains how to calibrate your copier and take advantage of the ColorWise®
color management system, as well as features in ColorWise Pro Tools™.

The Fiery Color Reference addresses concepts and issues associated with managing
color output of the Fiery and outlines key workflow scenarios. In addition, it offers
information on printing color documents from popular Microsoft Windows and
Apple Mac OS applications.

The Job Management Guide explains the functions of the job management utilities,
including Command WorkStation™ and DocBuilder Pro™, and how you can use
them to monitor and control jobs on the Fiery. This manual is intended for an
operator or administrator, or a user with the necessary access privileges, who
monitors and manages job flow, performs color calibration, and troubleshoots

problems that may arise.

Customer Release Notes provide last-minute product information and workarounds
for some of the problems you may encounter.
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Introduction
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About this manual

This manual explains how to manage color output on the Fiery Network Controller
for DocuColor 3535, and provides information on calibration and color profiles.

This manual is part of a set of documentation that includes manuals for users and
system administrators. The other manuals are available at your site—refer to them fora
complete description of your Fiery Network Controller for DocuColor 3535.

Note: The term “Fiery” is used in this manual to refer to the Fiery Network Controller
for DocuColor 3535. The name “Aero” is used in illustrations to represent the Fiery.
The term “Windows 9x” is used in this manual to represent Windows 98. The term
“Windows” is used to refer to Windows 95, Windows 98, Windows Me, Windows
NT 4.0, Windows 2000, and Windows XP wherever appropriate.

About this manual

This manual is organized to supply you with key information about managing
the color output of your Fiery.

* Chapter 1 describes the Fiery print options and how to get the best color results.
* Chapter 2 covers various methods of calibrating the Fiery.

* Chapter 3 takes you through the features of ColorWise Pro Tools. ColorWise Pro
Tools include Profile Manager, used to manage color profiles on the Fiery, and Color
Editor, which allows you to customize simulation and output profiles.
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* Appendix A provides information about color measurement instruments, available
as separately purchased options.

* Appendix B describes the Simple ASCII File Format (SAIFF), which can be used to

import toner density measurements from measurement devices.

* The Fiery Color Reference Glossary defines words in bold—for example, output
profile—that appear throughout this manual. Color terms and concepts, such as
“color space,” “spot color,” “gamut,” and “source profile,” are used throughout this
manual. If you are new to desktop color, or if any terms are unfamiliar, check
the Glossary.

Key features of ColorWise

ColorWise is the color management system (CMS) built into the Fiery and designed
to provide both casual and expert users with the best color output for a variety

of purposes. The ColorWise default settings provide high-quality out-of-box color
from many Windows and Mac OS applications. This allows casual users to achieve
quality output without knowing about or changing any color settings on the Fiery.

For consistent color, calibrate the Fiery on a regular basis. ColorWise Pro Tools include
an easy-to-use calibrator, which allows you to calibrate using either the scanning unit
that is part of the copier or an optional spectrophotometer or densitometer

(see Chapter 2).

ColorWise features allow you to modify printing results. Depending on your particular
needs, you can:

* Set the behavior of CMYK printing to emulate DIC, Euroscale, and SWOP offset
press standards.

* Match PANTONE and other spot colors for the best match when printed using

four-color press conditions or when printed using presses with extra, custom plates.
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Key features of ColorWise

* Select a color rendering dictionary (CRD), also called a rendering style, for RGB
printing. CRDs allow for rich, saturated printing of presentation graphics; smooth,
accurate printing of photographs; and relative or absolute colorimetric rendering for

specialized needs.

* Define the source of incoming RGB color data for better screen matching and
provide for better color conversion of RGB data with no source information.

* Define whether RGB data is converted into the full gamut of the copier or whether
it is first converted into the gamut of another device, such as a press standard. This
feature is helpful for making one device behave like another. It is also useful for
evaluating the appearance of the RGB file under different printing conditions
without having to reprocess the RGB data each time.

ColorWise color management (ColorWise) offers an open color architecture,
allowing users to customize the Fiery to meet new printing needs as they arise.
ColorWise supports ICC profiles, which are industry standard color profiles that
describe the color behavior of a device. Downloading ICC profiles to the Fiery enables
the Fiery to simulate a custom press (or another copier), as well as accurately print
colors from a particular monitor or a scanner. In addition, you can create customized

ICC profiles for the copier.

ColorWise also allows you to use any Status T densitometer by importing data in a
standard file format (see Appendix B). In this case, it is important to note that the
quality of the instrument used will determine the quality of the calibration.
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The following sections describe the options available from the ColorWise
color management system and explain how to customize the color settings for your
particular needs. They provide descriptions of the preset ColorWise default settings

and cover additional options for users who need to customize ColorWise.

For information on PostScript Level 2 or 3 printer drivers, see page 1-14. The section
also contains information on the capabilities of printer drivers and instructions for
setting color options with the PostScript drivers for Windows and Mac OS computers.

Managing color on the Fiery
To modify Fiery printing behavior, do any of the following:

¢ Select ColorWise options for an individual print job using menus that appear in the
printer driver.

* Select most ColorWise options as server defaults from the Color Setup application
in ColorWise Pro Tools (see page 3-22). Defaults can also be set from Fiery Setup, as
described in the Configuration Guide. These defaults will apply to all subsequent
print jobs unless you override them.

* Select some ColorWise options, particularly default ICC profile settings and
calibration options, from ColorWise Pro Tools. These options include default
Simulation Profile (see page 1-9), Simulation Method (see page 1-10), Appear in
Driver as (see page 3-7), default Source Profile (see page 1-7), RGB Separation
(see page 1-8), and associated calibration set (see page 2-4).

Applications can generate color data for the Fiery in many different color spaces.
The most common type of color data produced from office applications is RGB,
while prepress applications generally produce CMYK data. Desktop applications can
also generate spot colors, such as PANTONE colors. To complicate matters, a single
page may contain a mix of RGB, CMYK, and spot colors. The Fiery allows users to
control the printing of these mixed-color documents with features that apply
specifically to RGB, CMYK, or spot color data.
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Fiery color management generates CMYK data to be sent to the copier.

The following diagram illustrates the print options in the Fiery color management
process that affect color data conversions. You can access these print options when you
send a print job to the Fiery. Most of these options and settings are described in
subsequent sections of this chapter.

RGB Source Profile
Gamma
Phosphors
White Point

Rendering Style (CRD)
Brightness a
Pure Black Text/Graphics

Fiery

RGB Separation Color data sent
. I:> color E> to copier

Output profile processor

CMYK Simulation Profile

CMYK Simulation Method

Brightness

Pure Black Text/Graphics
Output profile

Spot Color Matching

RGB Source Profile is the only color option that applies strictly to RGB color data.
The other options that affect RGB color also affect the more rarely used Lab, XYZ,
and other calibrated color spaces.

Note: For users who are familiar with PostScript 3 color, RGB Source Profile affects all
CIEBasedABC color spaces (if the source space is RGB). If you send CMYK data

to the Fiery in CIEBasedDEFG format, for example, by choosing PostScript Color
Management in Adobe Photoshop, the Fiery Rendering Style selection—which
normally affects only RGB data—will also affect this CMYK data.
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You can specify settings for the following options by selecting print options when you

send a job to the Fiery. Some can also be set as defaults by the administrator during

Fiery Setup or using ColorWise Pro Tools. Settings specified using print options

override the defaults.

Fiery color print option

What it does

Color Mode (Mac OS computers)
CMYK/Grayscale

or

Print Mode (Windows computers)
Standard Color/Expert Color/Grayscale

Specifies the output color space of the job. Select CMYK, Standard Color, or
Expert Color for a full-color document.

Combine Separations
On/Off

Specifies whether to print separated CMYK data as a single, four-color
composite document (see page 1-5).

Rendering Style
Photographic/Presentation/Relative
Colorimetric/Absolute Colorimetric
(Default set at Setup or with ColorWise Pro
Tools)

Applies a Fiery color rendering dictionary (CRD) to RGB data (see

page 1-6), or to any incoming data with a PostScript source color space
definition, including CMYK.

Brightness
85% Lightest to 115% Darkest

Performs a color adjustment on all color channels to make the printed
output lighter or darker.

RGB Source Profile

EFIRGB/sRGB (PC)

/Apple Standard/Other/

Source 1-5/0ff

(Default set at Setup or with ColorWise Pro
Tools)

Applies an RGB source space definition to RGB data (see page 1-7). If you
choose the Other setting, you must also specify particular settings for Gamma,
Phosphors, and White Point. See the corresponding options in this table. This
option, along with Gamma, Phosphors, and White Point, only affects
DeviceRGB or calibrated RGB color spaces.

(Other) Gamma
1.0/1.2/1.4/1.6/1.8/2.0/2.2/2.4/2.6/2.8/3.0
(Default set at Setup or with ColorWise Pro
Tools)

Applies the specified gamma value to the RGB source space definition (see
page 1-7). To use this print option, you must choose Other as the RGB Source
Profile setting.

(Other) Phosphors

Hitachi EBU/Hitachi-Tkegami/NTSC/
Radius Pivot/SMPTE/Trinitron

(Default set at Setup or with ColorWise Pro
Tools)

Applies the specified phosphor (monitor type) information to the RGB
source space definition (see page 1-7). To use this print option, you must
choose Other as the RGB Source Profile setting.




1-4 | Fiery Color Management

Fiery color print option

What it does

(Other) White Point

5000 K (D50)/5500 K/6500 K (D65)/
7500 K/9300 K

(Default set at Setup or with ColorWise Pro
Tools)

Applies the specified white point value to the RGB source color space

definition (see page 1-7). To use this print option, you must choose Other as
the RGB Profile Source setting.

RGB Separation

Output/Simulation

(Default set at Setup or in ColorWise Pro
Tools)

Determines which CMYK color space your original RGB data will be
separated into—CMYK for the copier (Output) or CMYK for a specified

simulation (Simulation) (see page 1-8).

NoTE: When RGB Separation is set to Simulation, RGB colors are affected by
CMYK Simulation Profile and CMYK Simulation Method.

CMYK Simulation Profile
SWOP-Coated/DIC/Euroscale/
Simulation 1-10/Match Copy/None

(Default set at Setup or in ColorWise Pro
Tools)

Adjusts CMYK color data to simulate an offset press standard or a custom
color gamut defined at your site. The Match Copy setting bypasses Fiery
calibration to match a copy made from the copier glass. Choosing None
bypasses simulation (see page 1-9).

NOTE: Some of the Simulation settings have slightly different names depending
on the model of copier.

CMYK Simulation Method

Quick/Full (Source GCR)/Full (Output
GCR)

(Default in Setup or ColorWise Pro Tools)

Quick simulation applies one-dimensional transfer curves that adjust output
density only. The Full simulations apply colorimetric transformations that
adjust hue as well as output density (see page 1-10).

Output Profile

Dot DCX+ (US)/Line DCX+ (US)/DOT
ColoTech (Europe)/Line ColoTech
(Europe)/Output 1-10

(Default set at Setup or in ColorWise Pro
Tools)

The output profile is applied to all data in the print job (see page 1-10).
User-defined output profiles can be downloaded to the Fiery using ColorWise
Pro Tools (see Chapter 3).

Pure Black Text/Graphics

On/Off

(Default set at Setup or with ColorWise Pro
Tools)

The On setting optimizes the quality of black text and line art output.
(see page 1-11).

Black Overprint

On/Off

(Default set at Setup or with ColorWise Pro
Tools)

The On setting overprints black text and text/graphics placed on colored
backgrounds. Overprinting colored backgrounds eliminates white gaps and
reduces halo effects or misregistration of colors. The On setting automatically
activates the Pure Black Text/Graphics option (see page 1-11).
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Fiery color print option

What it does

Spot Color Matching
On/Off

(Default in Setup or ColorWise Pro Tools)

The On setting enables Fiery-defined matching of spot colors to their best
CMYK equivalents. Off instructs the Fiery to match color output to a CMYK
combination specified by the source application for the

document (see page 1-13).

Text and Graphics Enhancement
On/Off

The On setting sharpens the edges of text and vector graphics.

Screen Switching
On/Off

If you choose Off; all objects on the page will use a low-frequency screen. If
you choose On, text will use a high-frequency screen and graphics and image
objects will use a low-frequency screen.

Image Smoothing
Automatic/Off/On/Below 90-300 ppi

The On setting enhances the print quality of low-resolution images.

Sharpness
Softer/Normal/Sharper

This option enhances the sharpness and reduces jagged edges. To increase the
sharpness for printing image data such as photographs, select Sharper. To print
text or bitmap graphics, select Normal.

Black Detection
On/Off

If your job consists of black-only text pages combined with a significant
number of color pages, set this option to Off.

Copier Mode
Photo/Map

Select Photo if the file is a photograph; select Map if the file is a combination
of text and photographs.

Detailed explanations of how these and other settings affect your print jobs are

provided in subsequent sections of this chapter.

Combine Separations

The Combine Separations setting allows you to specify how to print separated CMYK

data. The Combine Separations options are:

* Off prints each separation individually.

* On combines separations as a single, composite-color document, and automatically

makes these settings for the following print options: Color Mode (CMYK),
Rendering Style (None), Pure Black Text/Graphics (Off), Spot Color Matching
(Off), and Black Overprint (Off).

For information about using the Combine Separations option with applications such
as Adobe Photoshop, see the Fiery Color Reference.
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Rendering styles

The Rendering Style option specifies a CRD for color conversions. To control the

appearance of images, such as prints from office applications or RGB photographs

from Adobe Photoshop, select the appropriate Rendering Style. The Fiery allows you

to select from the four rendering styles currently found in industry standard ICC

profiles.

Fiery rendering style

Best used for

Equivalent ICC
rendering style

Photographic—Typically results
in less saturated output than

Photographs, including scans
and images from stock

Image, Contrast, and
Perceptual

presentation rendering when photography CDs.

printing out-of-gamut colors.

It preserves tonal relationships

in images.

Presentation—Cireates Artwork and graphs in Saturation, Graphics

saturated colors but does not
match printed colors precisely
to displayed colors. In-gamut
colors such as flesh tones

are rendered well; similar to the

Photographic rendering style.

presentations. In many cases,
it can be used for mixed pages
that contain both presentation

graphics and photographs.

Relative Colorimetric—Provides
white-point transformation
between the source and
destination white points. For
example, the bluish gray of a
monitor will map to neutral
gray. You may prefer this style
to avoid visible borders when
not printing full-bleed.

Advanced use when color
matching is important, but you
prefer white colors in the
document to print as paper
white. It may also be used with
PostScript color management to
affect CMYK data for

simulation purposes.

Relative Colorimetric

Absolute Colorimetric—
Provides 70 white point
transformation between the
source and destination white
points. For example, the bluish
gray of a monitor will map to a

bluish gray.

Situations when exact colors are
needed and visible borders are
not distracting. It may also be
used with PostScript color
management to affect CMYK
data for simulation purposes.

Absolute Colorimetric
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RGB Source Profile

The RGB source profile setting allows you to define the characteristics of the RGB
data in your document so the appropriate color conversion can occur on the Fiery.
Commonly used monitor color spaces are available from the printer driver and from
the ColorWise Pro Tools Profile Manager. For special needs, use ColorWise Pro Tools
to download custom monitor or scanner profiles.

When you specify a setting other than None for the RGB Source Profile, the Fiery
overrides source color space definitions or profiles that other color management
systems may have specified. For example, if you specified a ColorSync System Profile
on your Mac OS computer, the RGB Source Profile setting overrides it. In cases where
you do nor want this setting to override another specified source color space, choose
the None setting.

When you specify a setting other than None for the RGB Source Profile—since the
color space definitions are overridden—the output from the Fiery is consistent across
platforms. The Fiery RGB Source Profile options are:

* EFIRGB specifies an EFI-defined color space recommended for users who have no
detailed information about their RGB data.

* sRGB (PC) specifies the industry standard definition for a generic Windows
computer monitor.

* Apple Standard specifies the definition of all standard Mac OS computer monitors.

* Other allows you to specify custom RGB source settings. If you choose Other as the
RGB Source Profile setting, you must choose settings for the Gamma, Phosphors,
and White Point options.

* Sources 1-10 specify the definitions you download as RGB source profiles. For more
information about downloading RGB source profiles, see page 3-4.

If you are printing with the PostScript driver from a Windows computer and have
two-way communication enabled, the name of each downloaded profile is
represented in the RGB Source Profile setting menu. If you are printing with the
AdobePS driver from a Mac OS computer, downloaded profiles appear as Source-1
through Source-10. For more information on two-way communication, see the User
Software Installation Guide.
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* None instructs the Fiery to allow the RGB sources you defined elsewhere, such as in
the application, to be used. When you set RGB Source to None, the appearance of
colors will zor be independent of the file type. For example, RGB EPS files will look
different from RGB TIFF files.

With RGB Source set to None, PostScript RGB data that contains a source color
space definition is converted using the CRD specified by the Rendering Style option
(see page 1-6). Non-PostScript RGB data and PostScript RGB data that does not
contain a source color space definition are converted using a general undercolor

removal (UCR) conversion method.

RGB Separation

The RGB Separation option determines how RGB colors (as well as Lab and XYZ
colors) are converted to CMYK. The name of this option is meant to be descriptive,

since the option defines the color spaces that will be used by the Fiery to “separate” the
RGB data into CMYK values.

The two choices available for this option determine whether RGB data is converted
into the full gamut of the copier (output) or is first converted into the gamut of
another digital printer or press standard (simulation). This feature is helpful for
making one device behave like another for RGB data. For example, if a high-quality
ICC profile is available for another print device, the copier can simulate the behavior
of that device.

RGB Separation is also useful for prepress applications. For example, it allows you to
experiment with the appearance of an RGB scan under different press printing
conditions, without having to convert the RGB data to CMYK data for each
condition. When the desired printing condition is found, convert the file to CMYK,
using the same CMYK simulation profile you used during the experimentation.

Note: The RGB Separation print option should be used in conjunction with the
Output Profile or CMYK Simulation Profile print options.

* Output converts all RGB colors into the CMYK color space of your copier (when set
to the printer’s default), or a customized CMYK color space for your copier (when
set to Output 1-10).

* Simulation converts all RGB colors into the CMYK color space for a specified
simulation (select the desired simulation with the CMYK Simulation Profile
print option).
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CMYK Simulation Profile

The CMYK Simulation Profile print option allows you to print press proofs or
simulations. This setting specifies the offset press standard or other color printing
device that you want to simulate. This option affects CMYK data only.

With the Windows printer drivers, you can also view an unlimited number of custom
Full simulations created using ColorWise Pro Tools. On Mac OS computers, you can
view up to 10 Full custom simulations. The number of custom simulations is limited
by the disk space on the Fiery.

If you are printing with the PostScript driver from a Windows computer and have
Two-Way Communication enabled, the name of each downloaded or custom profile is
represented in the CMYK Simulation Profile setting menu. If you are printing with the
AdobePS driver from a Mac OS computer, downloaded or custom profiles appear as
Simulation-1 through Simulation-10. For more information on Two-Way
Communication, see the User Software Installation Guide.

The None setting sends your original CMYK data to the copier in its calibrated state,
without conversions to simulate another printer. This setting is not generally
recommended, unless you want to bypass the conversion by ColorWise and use
another color management system.

The CMYK Simulation Profile setting you specify depends on the press standard for
which the CMYK data was separated.

* For images that were separated using a custom separation (such as a separation
produced with an ICC profile), choose the corresponding profile on the Fiery
with the CMYK Simulation Profile setting.

* For images that were separated for SWOP, choose SWOP as the CMYK Simulation
Profile setting.

Note: To properly simulate a printed image that was separated through the use of
an ICC profile, the same profile must be present on the Fiery. For more information
about downloading ICC profiles to the Fiery, see “Downloading profiles” on page 3-4.
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CMYK Simulation Method

The CMYK Simulation Method allows you to define your preferred
CMYK-to-CMYK conversion technique.

* Quick applies one-dimensional transfer curves to adjust output densities in the cyan,
magenta, yellow, and black channels. This technique leads to pleasant color output
from your copier because pure primary colors are not “contaminated” by other
colorants. While it is the fastest simulation method and perfect for drafts, avoid
using it for final documents that will be used as press proofs. Other techniques offer
more color simulation accuracy, which is expected by proofing applications.

* Full (Source GCR) provides a complete and accurate simulation based on colorimetric
transformations. Hues are preserved, even for primary colors. The (GCR) level that
was specified in the original (source) document is also preserved. Full (Source GCR)
is therefore an excellent simulation technique for the highest quality press proofing
applications.

* Full (Output GCR) is also a complete and accurate simulation method based on
colorimetric transformations. Hues are preserved, even for primary colors. With this
method, the Gray Component Replacement (GCR) level that was specified in the
original document is not preserved. Instead, all CMYK data is reseparated using the
GCR level specified by the Output Profile. This simulation technique is similar to
traditional ICC color matching methods and is appropriate for most documents
designed for the press, but reproduced on your copier.

Note: When you specify On for Pure Black Text/Graphics, and specify Full (Output
GCR) for CYMK Simulation Method, the black text and graphics in your document
are printed with 100% black-only toner.

Output profile

The output profile is applied to all data in the print job, so make sure the selected
profile is the right one for your job. The default output profile consists of both a profile
for your copier, describing its color characteristics, and a calibration target that
describes the expected behavior of the copier.

The output profiles provided with the Fiery correspond to a screening method, and to
the region for which the screen methods were developed (U.S. or Europe).
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In certain cases, you may want to customize the default output profile using the
ColorWise Pro Tools Color Editor to achieve particular color effects (see page 3-10).
If you do so, the new customized output profile is applied to all data in the print job.
Changing the output profile only does not affect its associated calibration target
(since the target is based on a copier model). You can edit D-Max values of the
calibration target separately (see page 3-10).

Use the ColorWise Pro Tools Profile Manager to download your own output profile to
the Fiery (see page 3-4). Downloaded output profiles are at first associated with the
calibration target that is tied to the default output profile. You can edit calibration
target D-Max values separately.

If you are printing with the PostScript driver from a Windows computer and have
enabled Two-Way Communication, the name of each downloaded or custom profile is
represented in the Output Profile setting menu. If you are printing with the AdobePS
driver from a Mac OS computer, downloaded or custom profiles appear as Output-1
through Output-10. For more information on Two-Way Communication, see the
User Software Installation Guide.

Pure Black Text/Graphics

The Pure Black Text/Graphics option affects the printout for black text and vector
graphics on a page. Under most circumstances, leave this option set to On. When
Pure Black Text/Graphics is on, black colors generated by applications are printed
using 100 percent black-only toner (for example, RGB = 0, 0, 0; CMYK = 0%, 0%,
0%, 100%; or K = 100%). This means the black text and line art will not exhibit
halftone artifacts and will not be misregistered, since there is only one toner used.
In addition, this setting eliminates blasting. This option is automatically set to On
when the Black Overprint option is set to On.

For some jobs, it is preferable to clear this option, for example, if the page includes
gradient fills that use black. The following table describes the behavior of the Pure
Black Text/Graphics option with black data defined in different color spaces.
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Note: Use the Pure Black Text/Graphics option only when printing composites, not
when printing separations.

Pure Black Text/Graphics

Input
black color on off
RGB Prints 100% black With the default profile, prints a rich black using
all toners.
CMYK Prints only with black toner, because CMYK

simulations preserve the black channel. The actual
amount of toner used depends on the current
simulation and the calibration state of the copier.

Spot Prints only with black toner, because spot color
simulations preserve the black channel. The actual
amount of toner used depends on the current
simulation and the calibration state of the copier.

Note: PostScript applications (such as QuarkXPress) may convert elements defined as
RGB =0, 0, 0 to four-color CMYK black before sending the job to the Fiery. These
elements are not affected by the Pure Black Text/Graphics option. For details, see

the application notes. Also, black text and line art defined as RGB = 0, 0, 0 in office
applications (such as Microsoft Word) are converted to single-color black

(CMYK = 0%, 0%, 0%, 100%) by the Microsoft PostScript Level 3 driver for
Windows 2000/XP. To print this single-color black at the maximum toner density of
the copier, set the Pure Black Text/Graphics option to On.

Black Overprint

The Black Overprint option allows you to specify whether or not black text—
defined as RGB = 0, 0, 0, or as CMYK = 0%, 0%, 0%, 100%—overprints colored
backgrounds.

* On—Black text overprints colored backgrounds, eliminating white gaps and
reducing halo effects or misregistration of colors. Setting Black Overprint to On
automatically activates the Pure Black Text/Graphics option.

 0ff—Black text knocks out colored backgrounds.
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Note: PostScript applications may perform their own black overprint conversions
before sending the print job to the Fiery.

One example of how you might use this setting is with a page that contains black text
on a light blue background. The background blue color is CMYK = 40%, 30%, 0%,
0% and the black text is CMYK = 0%, 0%, 0%, 100%.

* With Black Overprint On, the final text portions of the page are overprinted, or
combined with the underlying colors. This results in CMYK = 40%, 30%, 0%,
100% for the color used for the text. There is no transition in the cyan and magenta
toners, and the quality of the output is improved since it will not show artifacts near
the edges of the text. The option also works with text defined in the RGB color
space, that is RGB = 0, 0, 0.

* With Black Overprint Off, the border of the text is on an edge that has cyan and
magenta toners on one side (outside the text) and black toner on the other side
(inside the text). This transition may cause visible artifacts because of the practical
limitations of the copier.

Note: If you set Black Overprint Style to Text/Graphics, setting Black Overprint to On
allows black text or graphics to overprint colored backgrounds (see page 1-12).

Spot Color Matching

The Spot Color Matching option provides automatic matching of spot colors with
their best CMYK equivalents.

* On—The Fiery uses a built-in table to generate the closest CMYK matches of spot
colors your copier can produce. (New tables are generated when you add new output

profiles.)

NotE: Spot colors not included in the built-in table are treated as CMYK.

* 0ff—The Fiery uses CMYK equivalents defined by the spot color manufacturer,
such as PANTONE. These are the same CMYK equivalents used by applications
that include spot color libraries.

For jobs that include spot colors, set Spot Color Matching to On unless you are
printing press simulations. In that case, set Spot Color Matching to Off and choose the
appropriate CMYK Simulation setting (see page 1-9).
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For PDF jobs that include spot colors that are not included in the built-in table,
setting Spot Color Matching to On retains the spot color originally specified. The
Fiery references the built-in table to generate the closest CMYK matches of the original

spot color.

Note: Use the Spot Color Matching option only when printing composites, not when
printing separations.

Spot Color Matching and the PANTONE Coated Color Reference

The PANTONE Coated Color Reference (described in the Fiery Color Reference)
prints differently depending on the Spot Color Matching setting.

* On—The Fiery uses a built-in table to generate the best matches of the PANTONE
colors that your copier can produce. The PANTONE number is printed below each

swatch.

* 0ff—The Fiery prints swatches using the CMYK values recommended by Pantone,
Inc. (and used by applications that provide PANTONE color libraries). The CMYK
values used to generate the color, as well as the PANTONE number of the color, are
printed below each swatch. These CMYK values are printed through the selected
CMYK Simulation and Output Profile settings.

PostScript printer driver for Windows and Mac 0S

To access the printer driver options described in this section, choose

Start> Settings > Printers, right-click the appropriate printer (PPD) name, and choose
Properties (Windows 9x/Me), Document Defaults (Windows NT), or Printing
Preferences (Windows 2000/XP) from the pop-up menu. To access the Mac OS driver
options, choose Print from the File menu of your application. These settings are also
accessible from the Print Setup or Page Setup dialog boxes of most applications.

For Windows computers, the Fiery driver interface allows you to save combinations of
settings for later access. Additionally, you can choose different settings for individual
jobs from the applications you use.

The printer driver writes a PostScript file containing the instructions generated by your
application and the Fiery print options you chose. The printer driver sends the
PostScript file to the Fiery. The Fiery then performs PostScript processing and color
conversions and sends raster color data to the print device.
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Note: The following illustrations and instructions do not apply to all applications.
Many applications, such as Adobe PageMaker, Adobe Photoshop, Adobe Illustrator,
QuarkXPress, and CorelDRAW, have other color management options in addition to
those presented in the printer driver. For information on specific applications, see the
Fiery Color Reference.

Setting color management print options for Windows

This section explains how to set Fiery color print options with the Adobe PostScript
Printer Driver for Windows. This driver is a PostScript 3 printer driver that takes full
advantage of the color features of the Fiery. Before you proceed, complete the
following procedures:

¢ Install the Adobe PostScript Printer Driver and the Fiery PPD (see the User Software
Installation Guide).

* Set up the Fiery for printing (see the Configuration Guide).

* Install the ICC output profile for the Fiery on your Windows computer (see the User
Software Installation Guide).

TO SET PRINT OPTIONS FOR WINDOWS

Access the printer driver options, as described on page 1-14.

Click the Fiery Printing tab, and choose settings from the ColorWise menu for the
print options described on page 1-3.

»  Paper Source

Choose ColorWise




1-16 | Fiery Color Management

3.

Click Expert Settings.

@ & Standard Color

@ " Egpert Colar Exzpert Settings ... I K .
Click Expert Settings to access
@ " Grapscale additional ColorWise options

The Expert Color Settings flowchart appears. This window displays additional color
settings for the Fiery. Each option includes a menu from which you select settings for
your specific job.

Click Update to display the current Fiery settings.

If Update does not appear, make sure that Two-Way Communication is set up as
described in the User Software Installation Guide.

To specify custom RGB source settings, select Other for the RGB Source Profile and
click Custom Setup.

The Custom Setup dialog box allows you to specify custom RGB source settings
(see page 1-7).

[Other] Gamma

Printer's default

[Other] White Point

IPrinter's default j
[Other] Phosphors

IPrinter's default j

()8 I Cancel |

For most users, the default settings provide the right level of color control. For more
information about individual print options, see page 1-3.

Adobe PostScript printer driver for Mac 0S

This section explains how to set color management print options with the AdobePS
printer driver for Mac OS, a PostScript 3 driver that takes full advantage of the color
features of the Fiery and allows you to save a set of print option settings.
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Before you continue, complete the following procedures, as described in the
User Software Installation Guide:

* Install the AdobePS printer driver and the Fiery PPD.
* Select the Fiery in the Chooser and set it up with the Fiery PPD.

¢ Install the ICC output profile for the Fiery on your Mac OS computer (see the
User Software Installation Guide).

Note: The following illustrations and instructions do not apply to all applications.
Many applications, such as Adobe PageMaker, Adobe Photoshop, Adobe Illustrator,
QuarkXPress, and Corel DRAW, have other color management options in addition to
those presented in the printer driver. For information on specific applications, see the
Fiery Color Reference.

Setting color management print options

Choose settings for color print options from the various panes of the AdobePS driver
dialog box. To access the initial AdobePS dialog box, choose Print from the File menu
of your application.

NoTe: The term “pane” is used to describe the different pages that appear in the driver
dialog box when you make selections from the menu at the upper-left corner of the
dialog box. Each pane presents a particular set of print options.

The AdobePS driver includes the following Color Matching options.

* Color/Grayscale—When this setting is used to print to the Fiery, ColorWise
provides all color conversions on the Fiery. Typically, use this option when printing
to the Fiery.

* PostScript Color Matching—Can be used with PostScript devices, such as the Fiery.
It provides for color conversion using a color rendering dictionary (CRD) that is
downloaded with the print job. This method requires that the file is saved as an EPS
with PostScript Color Management selected.

Note: If you use the PostScript Color Matching option, the driver may, depending
on the application in use, attach a CMYK source definition to the CMYK data in
your document. In such a case, the CMYK data in the document is reseparated
using a Fiery CRD. The destination color space for the CRD is determined by the
RGB Separation print option. When RGB Separation is set to Simulation, CMYK
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data is printed according to all specified CMYK Simulation Profile and CMYK
Simulation Method settings. When RGB Separation is set to Output, CMYK data is
converted to the selected output profile’s CMYK color space.

* ColorSync Color Matching—Provides for color conversion o7 the host computer.
This option can be used with PostScript devices such as the Fiery, but it is intended
for use with PostScript Level 1 devices. If you use this option, you must specify
the Fiery ICC profile as the Printer Profile. ColorSync Color Matching is not a
suggested color matching method because it does not work in conjunction with all
applications and requires that you disable features of ColorWise on the Fiery.

To SET FIERY COLOR MANAGEMENT OPTIONS

1. In the AdobePS Print dialog box, choose Color Matching from the menu.

8.7.2(104)
Printer: [ AERO_Print s Destination:
. - | General ¥
Choose Color Matching l <)
Copies: D [ Collate [] Reverse Order
Pages: @ All
Grrome[Jro: [
Paper Source: @ All pages from: [Auto Select i]
O First page from: | AutoSelect 3]
Remaining from: [AutoSeIect ¢]

AV GeJ




1-19 | PostScript printer driver for Windows and Mac 0S

2. Choose Color/Grayscale from the Print Color menu.

8.7.2(104)

Destination:

Printer: [ AERO_Print B
[Cnlor Matching i]
Print Color: [Cnlor!Grayscale i]'

Printer Profile: | Printer's Default

Choose Color/Grayscale

AV
3. In the Printer Specific Options menus, choose settings for the print options described
on page 1-3.
8.7.2(104)
Printer: [[AERO_Print =i Destination:

- [ Printer Specific Optio... i]

Brightness :[ 100% Normal w

Color Mode :| CMYK hd

Rendering Style :[ Printer’s default - |
Pure Black Text/Graphics :[ Printer’s default |
Black Overprint:[ Printer’s default w |

Spot Color Matching :[ Printer's Default - |

RGB Source Profile :[ Printer's default v |

mD

4]

AV

4. If these settings are used regularly, click Save Settings to save them for

subsequent jobs.
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To SET FIERY COLOR MANAGEMENT OPTIONS FROM
MAC 0S X v10.2 OR LATER

1. In the Print dialog box, choose Printer Features from the menu.

Print

e
e

Printer: [ AERO_Print [

e
e

Presets: [ Standard |

Copies & Pages = j

Choose Printer Features
Copies: (1 | M Collated

Pages: @ all
(O Current page

) Selection

O Erom: |1 to: |1
() Page range:

Enter page numbers and/or page ranges
separated by commas (e.g. 2, 5-8)

@ { Preview ) ( Save As PDF... ) Cancel
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2. In the Printer Features menus, choose settings for the print options described on

page 1-3.
Print
Printer: [ AERO_Print )
Presets: | Standard )
[ Printer Features 5 j
Feature Sets: | FPColorWise 1 | :j
Color Mode : [ CMYK )
Rendering Style : [ Presentation | :j
Pure Black Text/Graphics : "on | :j
Black Overprint : [ On | :j
Spot Color Matching : [ Printer's Default | :j
@ ( Preview) ( Save As PDF... ) Cancel
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Chapter 2:
Color Calibration

Calibrating the Fiery ensures consistent, reliable color output. This chapter explains
how calibration works and provides instructions for all calibration procedures. You
can calibrate the Fiery using ColorWise Pro Tools in combination with any of the

following color measurement instruments, available as separately purchased options:
e X-Rite DTP41 automatic scanning spectrophotometer

* X-Rite DTP32 automatic scanning densitometer

 EFI Densitometer ED-100™ hand-held densitometer

* EFI Spectrometer ES-1000 hand-held spectrometer

By connecting the instrument to the serial port on your computer, you can quickly
measure calibration color patches and download measurements to the Fiery.
For information on setting up and operating the DTP41 and DTP32, see Appendix A.

Another way to obtain measurements is by using the copier’s built-in scanner as part of
y y g

the AutoCal™ or ColorCal™ methods, which do not require the use of a measurement

instrument and can be run from ColorWise Pro Tools.

For information on advanced calibration and simulation features available with
ColorWise Pro Tools, such as editing profiles and creating custom profiles, see
Chapter 3. A format for inputting color measurements from other densitometers
is described in Appendix B.

NoTe: The procedures described in this chapter are fundamentally the same for
Windows and Mac OS computers. The main differences are the interface cable and the
port used to connect to the measurement instrument. The illustrations in this chapter
describe the Windows version.

Note: The term computer is used to refer to any computer running
ColorWise Pro Tools.
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An overview of calibration

Calibration generates curves that adjust for the difference between the actual toner
densities (measurements) and the response expected by the output profile.

* Measurements represent the actual color behavior of the copier.
¢ Calibration sets are sets of measurements.

* A calibration target that describes the expected behavior of the copier is contained
in each output profile.

After you have calibrated the Fiery, a calibration set is stored. This calibration set will
be used when it is associated with an output profile. Every output profile has an
associated calibration set. If you have not specified one, the calibration set associated

with the default output profile is used.

If you change the calibration after a saved job has been processed (RIPped), you do not
need to reprocess (reRIP) the job. The new calibration affects the job without needing
to be reprocessed.

NoTe: Changing calibration has the potential to affect 2// jobs for a/l users, so consider
limiting the number of people authorized to perform calibration. Set an Administrator
password in Fiery Setup to control access to calibration (see the Configuration Guide).
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Understanding calibration

Although most users’ needs are met by the default calibration set, the Fiery allows you
to choose a calibration set to customize calibration for specialized jobs.

Calibration allows you to:

* Maximize the color reproduction capabilities of the Fiery.
* Ensure consistent color quality over time.

* Produce consistent output across Fiery servers.

* Achieve better color matches when reproducing spot colors, such as PANTONE

colors or other named color systems.

* Optimize the Fiery for using ColorWise rendering styles (CRDs) and CMYK
simulations, and for using ICC profiles.

How calibration works

Success in obtaining satisfactory print quality from the Fiery depends on many factors.
Among the most important are establishing and maintaining optimal toner densities.
The density is the measure of the light absorbed by a surface. By carefully regulating
toner densities, you obtain consistent printed color.

Even with a calibrated system, toner density is affected by service settings, humidity,
and temperature; density also tends to drift over time. Regular measurement detects
day-to-day variations in densities, and calibration corrects for them.

Calibration works by creating calibration curves on the Fiery that compensate for the
difference between actual (measured) and desired (target) density values. These
calibration curves are the graphic equivalent of transfer functions, which are
mathematical descriptions of changes that will be made to the initial data. Transfer
functions are often graphed as input or output curves.

The Fiery generates calibration curves after comparing measured values to the final
target values for each of the four toner colors. The target values are based on the output

profile specified.
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Measurements

Measurement files contain numerical values that correspond to the toner density
produced by the copier when it prints solid cyan, magenta, yellow, and black, and
graduated tints of those colors.

To create a measurement file, print a page of color patches. Then measure the patches
using either a color measurement instrument connected to a computer on the network
or, if it is available, the print device’s scanner. The new measurements are automatically
downloaded to the Fiery.

Output profiles and calibration sets

Output profiles and calibration sets define desired calibration results. One or more
output profiles and calibration sets are provided with the Fiery. When you calibrate the
Fiery, select the calibration set that corresponds to the typical printing jobs at your site.
This same calibration set can be associated with one or more output profiles. For more
information on output profiles, see page 1-10.

Scheduling calibration

In general, you should calibrate the Fiery at least once a day, depending on the
volume of print jobs. If it is very important to maintain consistent color, or if the
copier is subject to wide fluctuations in temperature or humidity, calibrate every few
hours. For optimal performance, calibrate whenever there is a noticeable change in
print quality.

If you need to split a print job into two or more batches to be printed at different
times, it is especially important to calibrate before printing each batch. You should
also calibrate the Fiery after copier maintenance. However, because the copier may be
less stable immediately after maintenance, wait until you have printed approximately
50 pages before you calibrate.

NoTE: Because printed output from the copier is very sensitive to changes in
temperature and humidity, the copier should 7oz be installed near a window or in
direct sunlight, or near a heater or air conditioner. Paper is sensitive to climate changes
as well. It should be stored in a cool, dry, stable environment, and reams should remain
sealed until they are needed.
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To monitor print quality, print the following color reference pages:
* Color Charts from Command WorkStation (see the Job Management Guide)

* Color reference pages included with the user software (see the User Software
Installation Guide)

All these pages include fully saturated color patches and pale tints of cyan, magenta,
yellow, and black. Images with skin tones offer a very good basis for comparison. Save
and compare pages you printed at different times. If there is a noticeable change in
appearance, calibrate the Fiery.

When you examine the Test Page, all color patches should be visible, even though they
may be very faint in the five percent and two percent range. Each color’s patch set
should show uniform gradation from patch to patch as the color lightens from 100
percent to zero percent.

If the solid density patches (100% cyan, magenta, yellow, or black) look less saturated
with time, show the pages to your copier service technician to determine whether
adjusting the copier can improve output.

Checking calibration status

To verify whether the Fiery is calibrated, which calibration set and output profile were

used, and when the copier was last calibrated:

* Print a Configuration page or Test Page from Command WorkStation, or print a
Configuration page from the Xerox DocuColor 3535.

e Select a calibration set in Calibrator—the last calibration and the user who
performed it are displayed.
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Using Calibrator

ColorWise Pro Tools Calibrator allows you to calibrate the Fiery using the
measurement method of your choice.

Changing the calibration has the potential to affect a// jobs for 4/l users, so consider
limiting the number of people authorized to perform calibration. Set an Administrator
password to control access to calibration (see the Configuration Guide).

Note: Multiple users can be connected to one Fiery with ColorWise Pro Tools, but
only one user at a time can use Calibrator. An error message appears if you try to
calibrate when another user is using ColorWise Pro Tools to calibrate.

Starting Calibrator

Start Calibrator from the ColorWise Pro Tools main window.

To CALIBRATE THE FIERY USING CALIBRATOR

1.

2.

Start ColorWise Pro Tools and connect to the Fiery.

® %

& ColorWize Pro Tools

Aero_DeviceMame

Calibrator Color Editar Frofile Manager Color Setup

For instructions on configuring the connection to the Fiery, see the User Soffware
Installation Guide.

Note: If the connection to the Fiery from Command WorkStation (which also allows
for access to ColorWise Pro Tools) is not established, you can start ColorWise Pro
Tools independently of Command WorkStation.

Click Calibrator.
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3. Use the Calibrator window to perform the calibration method of your choice.

Procedures for each calibration method are described in subsequent sections of
this chapter.

= Calibrator-Aero_DeviceMame = B3
Standard Expert

1. Select Measurement Method
I

Calibration methods . -

appear in this menu 2. Check Print Settings

Calibration Set

Calibrated: 2i28i02 8:19:48 PM
By User: Default
Method: Default

3. Generate Measurement Page

Frint...

4. Get Measurements

Measure... | Fram File... |

Restare Device | Aoply | Daone
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Expert Mode

Calibrator provides two modes: Standard Mode and Expert Mode. You can perform all
essential calibration tasks while in Standard Mode. Expert Mode offers two additional
options: Print Pages and View Measurements.

E= Calibrator-Aero_DeviceMame =10 =]
Standard Expert

1. Select Measurement Method 3. Generate Measurement Page

Calibration methods
appear in this menu

i | Print... |
2. Check Print Settings 4. Get Measurements

— Calibration Set

| J Measure... | From File... |
Calibrated: 2/28/02 8:19:48 PM p:RtintEageslioptional)
By User: Default

Method: Default |Comparison FPages j Frint... |

6. View Measurements (optional)

|Measurements Table j iew... |

Restare Device | Save to File... | Aoply | Daone |

With the Print Pages option, print a calibration Comparison Page showing the results
of the new measurements with any profile associated with the currently selected
calibration set. You can also create a custom comparison page and save it as a
PostScript or Encapsulated PostScript (EPS) file called CALIB.PS. Next, print the file
to the Hold queue of the Fiery from your application, or download it to the Hold
queue with Fiery Downloader. An additional way to create the CALIB.PS file is to
rename any job in the Hold queue using Command WorkStation (see the Job
Management Guide).
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With the View Measurements option, you can view the current set of measurements as
a table or graph that shows both the measurements and the target curves.

Y Meazurements vz Target

Output profile name
appears here

When more than one profile uses the same target, an additional menu called Plot
Against appears in the upper-right corner of the dialog box. It lists all output profiles
that use that same calibration set. Selecting an output profile from this menu displays
the target curves associated with that profile. If each output profile contains a unique
calibration target, the curves displayed also change when you switch profiles.
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Restoring default calibration measurements

Use the following procedure to return to default preset calibration measurements.

TO RESTORE DEFAULT CALIBRATION MEASUREMENTS

1.

2.

In the main Calibrator window, click Restore Device.

Click OK to restore the preset default calibration set.

fou are about to restore the default calibration for:
Current Calibration Set.

Cancel |

NoTe: Restore Device applies only to the currently selected calibration set.

Calibrating the Fiery with the DTP41

Using the ColorWise Pro Tools Calibrator application and the DTP41
spectrophotometer, you can quickly measure color patches generated by the copier
and automatically download these measurements to the Fiery.

NoTEe: Before using ColorWise Pro Tools and the DTP41 to calibrate the Fiery, follow
the instructions on page A-5 for calibrating the DTP41 spectrophotometer.
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To CALIBRATE THE FIERY USING THE DTP41

1.

Start Calibrator.

For instructions on starting Calibrator, see page 2-6.
Choose X-Rite DTP41 as the measurement method.

In the Check Print Settings pane, choose the desired calibration set.

Choose the appropriate calibration set for the type of media you use most often.

Note: For this calibration to take effect, the calibration set must be associated with one
or more output profiles. There is no need to make any new associations for the default
calibration set, since it is already associated with the default output profile.

In the Generate Measurement Page pane, click Print.

The Print Options dialog box is displayed.

Choose the appropriate options, and click Print.

Fage Type

|21 Sarted Patches =l

Faper Size

|LTRiA4 =l

Input Tray

|Aut0 Select j
Cancel |

For Page Type, choose either 21 or 34 Sorted Patches.

Paper Size is automatically set to LTR/A4 for 21 Sorted Patches, or 11x17/A3
for 34 Sorted Patches.

For Input Tray, choose the paper source for printing the measurement page.
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6. Retrieve the measurement page from the copier.

7. In the Get Measurements pane, click Measure.

The Measurement Options dialog box displays the specified Page Type and Paper

Size options.
8. Click Measure.

9. If necessary, choose the appropriate COM port for the DTP41 from the Available Ports
menu. Click Start Measurements.

Start - X-Rite DTP-41
—Instructions Fatch Infa
Selectthe portthat DTP-41 is connected to 34 Sorted Patches
and press "Start Measurements” to scan the 1131 TIA3
patch page.

Available Ports
ICOM1 vl

Start Measurements

Utilities |
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10. Insert the measurement page into the DTP41, starting with the cyan strip.

Measurements - X-Rite DTP-41 [x]

— Instructions

Measure the cyan strip.

Fosition the strip =0 that the patches are directly under the alignment mark.
Insert the strip past the front idler rallers until it stops against the rear drive
rollers {approximately 3 inches). Click"Read Strip" when ready.

— Status
Read Strip
Port  CON1 s e~ ® Previne | [ iEE |
Arcent e surerients | Cancel |

Follow the on-screen instructions to align the page properly.

11. Click Read Strip.
The DTP41 pulls the measurement page through automatically.

After the measurement page is read, Calibrator instructs you to insert and align the
page again for the next color.
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12.

13.

14.

15.

16.

Repeat the measurement process for the magenta, yellow, and black strips.

Measurements - X-Rite DTP-41 (<]

— Instructions

Measure the magenta strip.

Fosition the strip =0 that the patches are directly under the alignment mark.
Insert the strip past the front idler rallers until it stops against the rear drive
rollers {approximately 3 inches). Click"Read Strip" when ready.

— Status

Read Stri
he cyan strip was read successfully. 2
|
Port COMI [P e Previous | [ ERt |
Accept Measurerments | Cancel |

A check mark appears on the circle of the color just read, and the Status field indicates

the color was measured successfully.

Click Previous or Next to reverse or advance to another step in the measurement

sequence.

When the Status field indicates that all four color strips have been read successfully,
click Accept Measurements.

In the Measure dialog box, click OK.
Click Apply in the Calibrator window to implement the new calibration set.

Click OK in the Information dialog box.

This completes the Fiery calibration process.
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Calibrating the Fiery with the DTP32

Using the DTP32, you can quickly measure color patches and download these
measurements to the Fiery using ColorWise Pro Tools Calibrator.

Note: Before using ColorWise Pro Tools and the DTP32 to calibrate the Fiery, follow
the instructions on page A-11 for calibrating the DTP32 densitometer.

TO CALIBRATE THE FIERY USING THE DTP32

1.

Start Calibrator.

For instructions on starting Calibrator, see page 2-6.
In the Select Measurement Method pane, choose X-Rite DTP32.

In the Check Print Settings pane, choose the desired calibration set.

If more than one option appears, choose the appropriate calibration set for the type of
media you will use most often.

NoTE: For this calibration to take effect, the calibration set must be associated with one
or more output profiles. The default calibration set is already associated with the
default output profile, so there is no need to make any new associations.

In the Generate Measurement Page pane, click Print.

The Print Options dialog box appears.

Choose the appropriate options, and click Print.
For Page Type, choose either 34 or 21 Sorted Patches.

Paper Size is automatically set to LTR/A4 for 21 Sorted Patches, or 11x17/A3 for
34 Sorted Patches.
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For Input Tray, specify the paper source.

Fage Type
|21 Sarted Patches =l
Faper Size
|LTRiA4 =l
Input Tray
|Aut0 Select j

6. Retrieve the measurement page from the copier.

7. Click Measure in the Get Measurements pane.
The Measurement Options dialog box displays the specified Page Type and
Paper Size options.

8. (Click Measure.

In the dialog box that appears, follow the directions for feeding the measurement

page through the X-Rite DTP32.

The Status field displays instructions for selecting the port and feeding the
measurement page through the DTP32 four times, once for each color strip.

X-Rite DTP32 Measzurement x|

Status Fort

Jcom |

Select densitometer port and press
Start to hegin scanning.

L AL AN

Start |

Cancel

Aooept |
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10.

11.

12.

When the Status field indicates that the measurements were read successfully,
click Accept.

Click OK in the Measure dialog box.
Click Apply in the Calibrator window to implement the new calibration set.

Click OK in the Information dialog box.

This completes the calibration process.

Using the EFI Spectrometer ES-1000 or
EFI Densitometer ED-100

The EFI Spectrometer ES-1000 is a hand-held spectrophotometer that measures the
spectral light reflected from printed output and other colored materials. Since the
ES-1000 accurately measures both the density and color of printed output, it is an
effective tool for calibrating the Fiery.

The EFI Densitometer ED-100 is a hand-held instrument that measures the density of
printed ink and toner. Like the DTP32, the ED-100 is a reflection densitometer that
you can use to calibrate the Fiery.

The ES-1000 and the ED-100 are available as separately purchased options.

Setting up the ES-1000

To use the ES-1000 for calibration purposes, you must first set it up for use with your
computer. For best results, you should also calibrate the ES-1000 itself using the white
point calibration card that is included with the instrument.

For complete instructions on setting up and calibrating the ES-1000, see the
documentation that is included with the instrument.
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The following illustration shows the different parts of the ES-1000.

Measure button

Sample aperture

White tile reference

Cradle

Setting up the ED-100

To use the ED-100 for calibration purposes, you must first set it up for use with your
computer. For complete instructions on setting up the ED-100, see the documentation
that is included with the instrument.

The following illustration shows the components of the ED-100.

Indicator light

Measure button

Sample aperture
(underneath)
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Calibrating the Fiery with the ES-1000 or ED-100

You can use ColorWise Pro Tools in conjunction with the ES-1000 or ED-100 to
calibrate the Fiery.

To CALIBRATE THE FIERY USING THE ES-1000 or ED-100

1.

2.

Start Calibrator.

For instructions on starting Calibrator, see page 2-6.

Choose EFI Spectrometer ES-1000 or EFI Densitometer ED-100 as the
measurement method.

In the Check Print Settings pane, choose the desired calibration set.
Choose the appropriate calibration set for the type of media you will use most often.

NotEe: For this calibration to take effect, the calibration set must be associated with one
or more output profiles. There is no need to make any new associations for the default
calibration set, since it is already associated with the default output profile.

In the Generate Measurement Page pane, click Print.

The Print Options dialog box appears.

Choose the appropriate options and click Print.

Fage Type

21 Sorted Patches

Faper Size
|LTRiA4 =l
Input Tray
|Aut0 Select j

Frint Cancel |
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For Page Type, choose either 34 or 21 Sorted Patches, or 34 or 21 Randomized
Patches. Sorted patches are printed on the page in the order of their hue and saturation
levels. Randomized patches are printed on the page in random order, to help

compensate for density inconsistencies on different areas of the page.
Paper Size is automatically set to LTR/A4 for 21 Patches, or 11x17/A3 for 34 Patches.

For Input Tray, specify the paper source for printing the measurement page.
Retrieve the measurement page from the copier.

Click Measure in the Get Measurements pane.

The Measurement Options dialog box appears.

Choose the appropriate options, and then click Start.

Measurements Options E3

Fage Type
|21 Sorted Patches =l

Clicks Per Patch Audio Feedback
[ i
Port

JauTo =l

Page Type is automatically set to the measurement page type that you printed in step 5.

Click the arrow buttons next to the Clicks Per Patch field to choose the number of
measurements you want to take for each patch on the page. When you choose multiple
clicks, the average value of all measurements taken for the patch is returned to the

Fiery. Multiple measurements are more accurate, but may take more time.

To hear a confirmation tone each time a measurement is recorded, select the Audio
Feedback option. A single tone indicates a successful measurement; two tones indicate
a measurement error. If you have specified multiple clicks per patch, the tone sounds
after you take the final measurement.
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If necessary, choose the appropriate COM port for the ES-1000 or ED-100 from the
Port menu.

When you click Start, the Measurements window appears. Directions for measuring
the patches appear in the Status area.

Please measure
Strip A, Patch 1
A B C F 6 H
[ ] I
[z JE=f 2 | [z JFaf 2]
EN | HE | | E
[+ JEef ¢ ] [+ JCef 4]
[s |5 0[5 | (s |[s1[s |
[6 J[e [ o] [6 J[ e [ o]
[ [ 7] [ [ 7]
[2 [ & ][ 8] [2 J[ e ][ 8]
(5 J[s [ s | (5 )[ s [ s |
[0 J[ 0 J[ 1o [0 ][ 10 J[ 10 ]
1 1
ACCERT Cancel

9. Place the ES-1000 or ED-100 over the specified patch on the Measurement Page,
making sure to center the sample aperture over the patch. Press Measure to take
the measurement.

NoTe: For a more accurate measurement, place several plain sheets of paper beneath
the Measurement Page to block underlying colors from being read by the instrument.

If you have specified multiple clicks per patch, continue pressing Measure to take the
required number of measurements. We recommend that you move the ES-1000 or
ED-100 slightly after each measurement, while keeping the sample aperture within
the patch.
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10.

11.

12.

13.

When the patch has been measured successfully, a check mark appears in the patch
preview in the Measurements window. The window identifies and highlights the next
patch to be measured.

Please measure
Strip A, Patch 2
Strip
A B (o} D E F G H
AT | |
[l - | - 2] 2 ]
R[N | |
[+ JCe [ ¢« DR « [ e[ « |
[5 1[5 1[ s |WSWEsTl s J[s ][ 5 ]
[ e I[e [ e I[e ][ e ][e |[&][s]
INEA | NG N I | N N
[s e ][s[e][=]1[=][z] =]
[5 J[ s [s J[s ][5 ][a]fs][s]
(1o J[ o J[ oo J[ ro J[ 1o J[ 10 J[ 1o ][ 10 ]
[ ] [ ]
ACCERT Cancel

Repeat step 9 to measure each successive patch on the Measurement Page.

Start with Al and continue down Column A. When you have finished measuring all
the patches in Column A, proceed to Column B in the same manner until all columns
have been measured.

To retake a measurement, select the desired patch preview in the Measurements
window and measure the patch on the page using the ES-1000 or ED-100.

NoTE: You must take the measurements in the order outlined in the Measurements
window and on the measurement page.

When all the patches have been read successfully, click Accept.
Click Apply in the Calibrator window to implement the new calibration set.

Click OK in the Information dialog box.

This completes the Fiery calibration process.
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Using AutoCal or ColorCal

AutoCal and ColorCal allow you to calibrate the Fiery without using an additional
spectrophotometer or densitometer. Instead, these methods use the copier’s built-in
scanner to measure toner density values.

AutoCal is compatible with earlier Fiery servers. AutoCal and ColorCal have the
following differences:

* Scanner calibration—ColorCal lets you calibrate the scanner (copier feeder) using
the Kodak Color and Gray Scale strips. AutoCal lets you calibrate the copier using
the Kodak Gray Scale strip; scanner calibration is not available.

* Measurement page—For ColorCal, square black-and-white and color patches are
randomly printed on the ColorCal Measurement Page. This allows ColorCal to be
less influenced by copier conditions, providing greater accuracy in color
reproduction and calibration.

You can perform AutoCal or ColorCal calibration from ColorWise Pro Tools.
For troubleshooting during the AutoCal procedure, see the Job Management Guide.

Note: To calibrate using AutoCal or ColorCal, you will need the Kodak Gray Scale
strip included in the customer media pack that came with your Fiery.

Calibrating with ColorWise Pro Tools and AutoCal or ColorCal

TO PREPARE FOR CALIBRATION

1.

2.

On the Copier Control Panel, press the Access button (key icon).
Enter your password.

Choose Confirm.

Choose System Settings>System Settings>Scan Mode Setting>Others.
For Color_space, select 1 (dRGB).

Choose Close until the System Settings screen appears. Then choose Exit.
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To CALIBRATE WITH COLORWISE PRO TooLS AND AUTOCAL OR COLORCAL

1.

2.

7.

Start ColorWise Pro Tools (on your Mac 0S or Windows computer).

Start Calibrator.

For instructions on starting Calibrator, see page 2-6.

In the Select Measurement Method pane, choose AutoCal or ColorCal.

In the Check Print Settings pane, choose the desired Calibration Set (Dot Screen

or Line Screen).

Click Print in the Generate Measurement Page pane.

Choose the Input Tray to use for the measurement page and click Print.

Fage Type
|AutDCaI Page j
Faper Size
|LTRiA4 =l
Input Tray
|Aut0 Select j

Fage Type
|Co|0rCaI Measurement Page j
Faper Size
|LTRiA4 =l
Input Tray
|Aut0 Select j

Cancel |

Cancel |

AutoCal

The Page Type is automatically set to AutoCal Page or ColorCal Measurement Page.

ColorCal

The Paper Size is automatically set to LTR/A4.

Click OK when prompted.
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10.

11.

12.

13.

14.

15.

Retrieve the Measurement Page from the copier.

Click Measure in the Get Measurements pane.
If you chose the AutoCal method, skip to step 18.

If you chose the ColorCal method, an alert message appears, asking if you want to

calibrate the copier’s scanner.

Calibrate Scanner?

@ Scanner calibration is recommended only if scanner

characteristics hawve changed.
Do youwant to calibrate scanner?

veo | i | el |

If you are using ColorCal and want to calibrate the scanner, click Yes.

Choose the Input Tray to use for the scanner measurement page and click Print.
Retrieve the scanner measurement page from the copier.

Place the Kodak Gray Scale strip, Kodak Color Control Patches strip, and scanner
measurement page in the correct positions on the copier glass for scanner calibration.

Place the Gray Scale strip face down on the copier glass so that it is centered along the
top edge of the scanner measurement page. Then place the Color Scale strip face down
on the copier glass so it is centered below the Gray Scale strip. Finally, place the
scanner measurement page (second one printed) face down over the strips.

From the Copier Control Panel, choose Menu >Scan >Job Template.

Choose ColorCal as the desired calibration template.

Do not use the screen to edit the Template Description or make any other changes.

Press the Xerox DocuColor 3535 Scan button (large green button).
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16.

17.

18.

19.

20.

To perform the scanner calibration, click Continue in the ColorCal dialog box.

Scanner Calibr

on Setup

8

ColorCal E

Place grayscale and color target face down
according to the instructions printed on the
Scanner Calibration page. Press Continue.

Cancel

After the scanner is calibrated, another dialog box appears, prompting you to calibrate

the Fiery.

Click Measure in the AutoCal or ColorCal Get Measurements pane.

Follow the directions in the dialog box for placing the Gray Scale strip and the AutoCal
or ColorCal measurement page on the copier glass. Click Continue.

AutoCal

_

Place grayscale strip face down so that it
will he centered along the top edge ofthe
AutoCal page. Then, place AutoCal page
face down aver the grayscale sirip, atthe
upper left hand corner ofthe scanner
glass. Press Caontinue

{"Continue

Cancel

Place Patch Page

ColorCal E

Place grayseale strip face down so that it
will be centered along the top edge of the
ColorCal page. Then, place ColorCal page
face down over the grayscale strip, at the
upper left hand corner ofthe scanner glass.
Press Continue.

Cance|

AutoCal

ColorCal

From the Copier Control Panel, choose Menu >Scan >Job Template.

Choose the desired calibration template: AutoCal or ColorCal.

Do not use the screen to edit the Template Description or make any other changes.
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21. Press the Xerox DocuColor 3535 Scan button (large green button).
22. Click OK in the Calibrator Information dialog box.
23. Click Apply in the main Calibrator window to implement the new calibration set.

24. Click OK in the Information dialog box.

This completes the calibration process.

TO COMPLETE CALIBRATION

1. On the Copier Control Panel, press the Access button.

2. Enter your password.

3. Choose Confirm.

4. Choose System Settings>System Settings >Scan Mode Setting >0thers.
5. For Color_space, select 0 (sRGB).

6. Choose Close until the System Settings screen appears. Then choose Exit.

Calibrating from the Xerox DocuColor 3535

You can also calibrate from the Copier Control Panel without using Calibrator.
For more information, see your Xerox DocuColor 3535 documentation.

TO CALIBRATE USING XEROX DocuCOLOR 3535 CALIBRATION

1. On the Copier Control Panel, press the Access button (key icon).
2. Enter your password.
3. Select Confirm.

4. Choose System Settings>System Settings>Common Settings>Image Quality
Adjustment>Auto Gradation Adjustment.
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In the Auto Gradation Adjustment screen, select the appropriate option:
¢ Print Job—to calibrate the Line Screen calibration set.

¢ Network Controller 1 or Network Controller 2—to calibrate the
Dot Screen calibration set.

Follow the on-screen instructions to load the print media and press Start.

Follow the on-screen instructions to place the printed test pattern on the copier glass
and press Start.

When the scanning and calibration is complete, choose Close until the System Settings
screen appears.

Select Exit.



Chapter 3:
ColorWise
Pro Tools

3-1 | Profile Manager

Designed to give you flexible control of color printing, ColorWise Pro Tools
include the following color management tools:

¢ Calibrator (see Chapter 2)
¢ Color Editor

* Profile Manager

¢ Color Setup

& ColorWize Pro Tools

Aero_DeviceMame

W

Calibrator Color Editar Frofile Manager Color Setup

ColorWise Pro Tools for Windows and Mac OS computers are fundamentally the
same; differences are noted in this chapter. The windows and dialog boxes illustrated
are the Windows versions. For information on installing and configuring a connection
to ColorWise Pro Tools, see the User Software Installation Guide.

Note: If the connection to the Fiery from Command WorkStation (which also allows
for access to ColorWise Pro Tools) is not established, you can start ColorWise Pro
Tools independently of Command WorkStation.
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Profile Manager

Profile Manager allows you to manage and edit ICC profiles. In the case of the Fiery,
these profiles are divided into RGB Source, Simulation, and Output profiles:

* RGB Source contains all monitor profiles resident on the Fiery. RGB Source profiles
are used to define the source color space for RGB colors processed by the Fiery.

Note: If you use Photoshop 6.x or 5.x, you can upload the profile for your selected
working space to the Fiery and choose that as your RGB Source profile. For more

information, see the Fiery Color Reference.
* Simulation contains printer profiles used to simulate another device on the Fiery.

* Output contains copier profiles that describe the copier. For more information on
output profiles, see page 1-10.

Note: Changing the Fiery default profiles affects a// jobs for all users. Consider
limiting the number of people authorized to use ColorWise Pro Tools by setting an
Administrator password.

The following profiles are provided with the Fiery.

RGB Source:
* sRGB (PC)—source color space for a generic Windows computer monitor

* Apple Standard—standard source color space for Mac OS computer monitors with
older versions of ColorSync

* EFIRGB—preset default setting for a Fiery

Simulation:
* SWOP-Coated—United States press standard
* Euroscale—European press standard

* DIC—]Japanese press standard
In addition, one or more output profiles are provided with the Fiery.

For more information about output profiles, see page 1-10.
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Setting the default profiles

The default profiles are applied to all print jobs sent to the Fiery, unless you override

them using print options. Therefore, the defaults should be the most commonly

used profiles.

To SPECIFY A DEFAULT PROFILE

1. Start ColorWise Pro Tools and click Profile Manager.
B2 Fiery Profile Manager:Aero _[O]x]
‘ Browse: 1y ‘ Delete Edit Profile Settings:

Description

Generic EBU 1.5 Garma Manitar
Generic EBU 1.8 Garma Monitar
Generic EBU 2.2 Garmma Monitar
Generic P32 1.5 Gamma Monitor
Generic P22 1.8 Gamma Monitor
Generic P22 2.2 Gamma Manitar

]

8 | Description:

RGB Source
Appear in Driver as.

8 Apple Standard

8 sRGB(FC)
8 EFRGB

Apple Standard
SRGB
EFIRGE

8 | Description: Appear in Driver as.

& DICEF)
8 Euroscale (EF))
© 8 SWOP-Coated (EF)

DI
Euroscale
SWOP-Coated

8 | Deseription: Calibration Set | Appear in Driver as,

I

Output profiles
appear here

View [Descripion  ¥] T 1

Filename: Device Class Creation Date:

Desaription: Last Modified: Dane

Gopyright A

[T

The left side of the main Profile Manager window lists the ICC profiles in the default
directory of your computer; the right side lists the three profiles on the Fiery.

The lock icon (&) to the left of a profile name indicates that the profile cannot be
deleted and can be edited only if saved under a new name. Only Simulation and
Output profiles can be edited.

A small icon to the left of a profile name indicates the default profile for each category
(RGB Source, Simulation, and Output). If you designate a different profile as the
default, the icon appears next to your designated profile. The icon indicating the
default RGB Source and Output profiles looks like a target (i1). The icon indicating
the default Simulation profile changes in appearance depending on whether the default
RGB Separation setting is set to Simulation (#) or Output ().

2. Select the profile you want as the default for a profile type and click Profile Settings.
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In the Profile Settings dialog box, click Default and click Apply.

Click OK.

In the main Profile Manager window, the target icon appears next to the new default
profile you specified.

Repeat steps 2 through 4 for each type of profile.

If no default is set for RGB Source, the RGB Source print option is set to None. If no
default profile is set for Simulation, the CMYK Simulation print option is set to None.
For more information on print options, see Chapter 1.

The Output profile always has a default profile. To change the Output defaul, select a
preset profile you want as the default and click Profile Settings. Or create a new default
under a new name by selecting a preset profile and specifying your choice of the
calibration set in the Use Calibration Set menu and a new name in the Profile

Description menu.

Downloading profiles

The Fiery includes default profiles. You can download additional profiles from any
computer connected to the Fiery.

To DOWNLOAD A PROFILE

1.

Start ColorWise Pro Tools and click the Profile Manager.
The left side of the main Profile Manager windows lists the ICC profiles in the default

location on your computer.

* Windows 9x/Me—Windows\System\Color

¢ Windows NT 4.0—Winnt\System32\Color

* Windows 2000—Winnt\System32\Spool\Drivers\Color
* Windows XP—Windows\System32\Spool\Drivers\Color

* Mac 0S—System Folder: Preferences: ColorSync Profiles for ColorSync 2.0, and
System Folder: ColorSync Profiles for ColorSync 2.5 or later
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2. If the desired profile does not appear, click Browse to go to a different directory.
Browse to the directory containing the profile you want to download and click OK.

3. When the profile you want to download appears in the list in the main Profile Manager
window, select it.

If the profile is compatible with the Fiery, a green arrow indicates that the profile is
available for downloading. Only output device profiles are downloadable to Simulation
and Output. Only input device profiles are downloadable to RGB Source.

P

NoTe: On Windows computers, the profiles must have an extension of .icc or .icm to
be listed. On Mac OS computers, the profiles must have a file type of “profile.”

All ICC profiles in the selected directory on your computer are displayed in the list in
the main Profile Manager window. However, because a profile is listed does not
necessarily mean it can be downloaded to the Fiery.

Simulation profiles should be profiles only for those devices you want the Fiery to
match in terms of color output characteristics. Output profiles should be profiles only
for the copier to which you print. Although you can download CMYK printer profiles
as Simulation or Output, consider how they will be used. If you want the Fiery prints
to look like another printer, download that profile as a Simulation. If you have a
custom profile of the copier you print to, download that profile as an Output profile.

4. Click the arrow to download the profile and click OK when the download is complete.

The new profile now appears in the list of profiles on the right side of the Profile

Manager main window.

For Windows 2000/XP and Mac OS computers, this profile must be associated

with one of the predefined names (Source-1 through Source-10 for RGB Source,
Simulation-1 through Simulation-10 for Simulation, or Output-1 through Output-10
for Output) or set as the default before it can be used. For Windows 9x/Me/NT
computers, all profiles can appear in the printer driver by their profile descriptions (see

“Defining profiles” on page 3-7).

Note: When an output profile is downloaded, it inherits the calibration target of the
current default output profile.
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Editing profiles

You can customize the profiles on the Fiery to meet your specific needs and the
characteristics of your copier using Color Editor, either directly or through Profile
Manager. For more information on editing profiles, see “Color Editor” on page 3-10.

Managing profiles

Profile Manager allows you to back up profiles to ensure that no custom profiles are
lost when the Fiery software is updated. You can also upload a copy of a built-in Fiery
profile to your workstation in order to use it with an ICC-aware application, such as
Photoshop. Profile Manager also allows you to delete unwanted profiles.

NoTE: You can back up and delete only those profiles that appear in the main Profile
Manager window without a lock icon next to them. Locked profiles cannot be deleted,
but most can be backed up.

TO BACK UP PROFILES

1.

2.

Start ColorWise Pro Tools and click Profile Manager.

Select the profile on the Fiery to upload.

The arrow in the middle of the Profile Manager window turns green and points to the
left, indicating the profile is available for upload.

Click the green arrow, choose a name and location for the profile, and click Save.

The name will be the file name of the profile, but the profile description will be the
original description, or the one you entered in the Profile Settings dialog box.

Note: When saving the profile on a Windows computer, include the extension .icm.
If the extension is not included, additional dialog boxes appear.

Click OK when you are notified that the profile was successfully uploaded.

Delete profiles to ensure that the wrong profiles are not used, and to free up disk space
on the Fiery (although profiles are small and do not take up much space).
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To DELETE PROFILES FROM THE FIERY

1.

2.

Start ColorWise Pro Tools and click Profile Manager.

Select the profile you want to delete and click Delete.

A Warning dialog box asks you to confirm the deletion.

NoTE: You cannot delete preset profiles, profiles that are currently set as default, or
profiles that are linked to any of the predefined custom names, for example

Simulation-1.
Click Yes to delete the profile.

To delete a profile currently set as the default or associated with a custom name,
click Profile Settings and clear the default option.

Defining profiles

For Windows 2000/XP and Mac OS computers, before you apply any downloaded or
edited profile to a print job, that profile must be linked to one of the predefined
custom names, or you can set the profile as the default for all print jobs (see “Setting
the default profiles” on page 3-3). Ten names are available for custom profiles—
Source-1 through Source-10 for RGB Source, Simulation-1 through Simulation-10 for
Simulation, or Output-1 through Output-10 for Output.

For Windows 9x/Me/NT computers, all profiles appear by their actual names in the
printer driver. These fixed names are used in the printer driver, so you can select
profiles per job even if your driver does not have the capability to obtain an updated
list from the Fiery.

NoTE: A custom simulation profile is used to illustrate this procedure. The same steps
apply for defining output profiles.
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TO DEFINE A CUSTOM SIMULATION PROFILE

1.

2.

Start ColorWise Pro Tools and click Profile Manager.

[ Fiery Profile Manager:Aero _[olx]
‘ Biowse: | [CrwioowseYsTEMColor ] ‘ Delete Edit | Profile Getings
RGB Source
Description [ & | Deseription: Appear in Driver a5
Generic EBU 1.5 Garnma Monitor = [ |® 8 Applestandard Apple Standard
Generic EBU 1.8 Garmma Monitar 8 sRoB (PO SROB
Generic EBU 2.2 Gamma Manitar a erRoB EFIRGB
Generic P22 1.5 Gamma Monitor
Generic P22 1.8 Gamma Monitar L (=]
Generic P12 2.2 Gamma Monitor
8 | Description: Appear In Driver 5.
~— | 8 DICER) DIC ]
8 Euroscale (EF)) Euroscale
D A SwOP-Coated (EFI) SWOP-Coated
DIC-new =
= Custom profile
& | Deseription: Caliotation Set | Appeat in Driver as created with
— B Color Editor
view: [Descrition v 'l—— =l
Filaname. Device Clase Crastion Data
Deseription: Lsst Modiied _ ooe |
Copyiiaht y

For the purposes of this example, assume DIC-new is a custom simulation profile
created with Color Editor and, as such, no information is displayed for DIC-new
under the heading “Appear in Driver as.”

NoTE: You can define custom profiles only. Default profiles are predefined and cannot

be changed.

Select DIC-new in the Simulation list, and click Profile Settings or double-click
DIC-new.

Select the “Appear in Driver as” option, choose one of the predefined custom
simulation names (Simulation-1 through Simulation-10) from the menu, and then
click Apply.

Note: Choose a name that is not already linked with another simulation. You cannot
define two profiles with the same name.
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NoTe: Although you cannot delete a preset profile, you can use the name of a preset
profile name for your edited profile when you select the “Appear in Driver as” option.

This replaces the preset profile with your own profile.

ulation Profile Settings

— Profile Description

|DIC-new
©[ Default

—|7 Appear in Driver as...

|simulation-1

Cancel |

apply |

In Profile Settings, you can also change profile descriptions for all non-locked profiles.

4. Click OK.

Deseription

& | Description

B3 Fiety Profile Manager:Aero - [Of ]
‘ Browse: | [ ‘ Delete Edit | Profile Setings

RGB Source
Appear in Driver s

Generic EBU 1.5 Garmma Monitar
Generic EBU 1.8 Gamma Monitar
Generic EBU 2.2 Garma Manitar
Generic P22 1.5 Gamma Monitor
Generic P32 1.8 Gamma Monitor
Generic P32 2.2 Gamma Monitor

View: [Descrintion =

A apple Standard
B sRCB(PC)
8 EFRGB

8 | Description: Appear in Driver as.

Apple Standard =
SRGE
EFIRGB

o

DIC (EFI)
Eutogcale (EFI)
SWOP-Caated (EFD)
DIC-new

& | Description

Calibration Set

Dic =
Eurogeale
SWOP-Coated

Simulation- 1

[T

Appear in Driver s

—

|

[T

Filename:
Deseription:
Copyright

bevice Class

Creation bate:
Last Modifisd.

Dane

)

DIC-new will appear
in driver as
Simulation-1

Simulation-1 now appears under the “Appear in Driver as” column for DIC-new.
Choosing Simulation-1 from the CMYK Simulation option of the printer driver

applies the DIC-new simulation to the print job.
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If you do not define a custom simulation profile, your job will print with CMYK
Simulation Profile set to None. If you do not define a custom RGB Source or Output
profile, the default profile is used.

Considerations for defining Qutput Profiles

The procedures for defining Output Profiles is similar to the preceding example for
defining Simulations profiles. However, note these differences:

For output profiles, the predefined custom names are Output-1 through Output-10.

When you choose Profile Settings for an output profile, the Use Calibration Set
options also appear. You must calibrate the Fiery with this calibration set before

this option has any effect. If you have never measured for this calibration set, default
measurements are used. For more information about calibration sets, see page 2-3.

Color Editor

Color Editor allows you to customize simulation and output profiles. Access Color
Editor directly by clicking its icon in the ColorWise Pro Tools main window, or
indirectly, through the Profile Manager.

Editing profiles

Color Editor allows you to create custom profiles by editing existing simulation or
output profiles and saving the changes as a new profile. Use Color Editor to fine-tune a

profile on your Fiery to meet your exact specifications.

NoTE: You cannot edit source profiles; only simulation and output profiles can
be customized.

Color Editor has two Edit Modes for editing output profiles:
* Custom—Edit output profiles and save customized versions of them.

* % Density—View the calibration target, which is one component of the output
profile. You cannot make changes to the calibration target in this window, but you
can import a new target (see page 2-3).
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Color Editor also has several Edit Modes for editing simulations:

* Master—Create a custom master simulation that affects all print jobs to which it is
applied, unless a linked simulation exists for the selected combination of simulation
profile, simulation method, and output profile.

* Quick, Full (Source GCR), or Full (Output GCR)—Create custom /inked simulations.
Linked simulations affect the print job only if the corresponding simulation profile,
simulation method, and output profile are selected. If you choose an output profile
and simulation method for which you have created a custom linked simulation, that
simulation is applied automatically to the job. If you choose a simulation method or
output profile for which there is no custom linked simulation, the master simulation
is automatically applied. For detailed information about simulation methods,

see page 1-10.

NoTe: If you made edits to a master simulation after you created a linked simulation,
the edits are not applied to the linked simulation.

To EDIT A SIMULATION PROFILE IN MASTER MODE OR AN
OUTPUT PROFILE IN CustoM MODE

1.

2.

Start ColorWise Pro Tools and click Color Editor.

Choose Simulation or Output from the View menu.

Simulation lists the simulation profiles resident on the Fiery, and Output lists the
output profiles resident on the Fiery.

Select Profile B3
Description | Modified
DIC (EFD 28702112817 A

Euroscale (EFl) 2/9/02 4:10:31 P
Coated (EFI) A

Description: |SWOP-Coated (EFIy

Wiew: |Simulation =l Cancel I
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3.

Choose a profile to edit and click Select.

Another method is to open the Profile Manager, select a profile, and then click Edit.
For a simulation profile, choose Master from the Edit Mode menu. For an output
profile, choose Custom from the Edit Mode menu.

For instructions for using Quick, Full (Source GCR), or Full (Output GCR) mode, see
page 3-16.

E Fiery Color Editor:SwWOP-Coated [EFI] M=
Edit Mode
= IMaster vl
B
- ‘:’ Cyan
: L e =]
B Magenta
2 “ellow
2 Black
]
g = Brinhtness - | +|
i i
S DotGain.. |
0 0 @ T 4 € & 70 =W 4 1m
Input %0
Input Qutput
fo | o | Add Refmove

Test Print... Impart... Select Profile... Save... Daone

You can use this dialog box to view or edit profiles. The graph allows you to view and
manipulate color output values.

Note: When you edit an output profile in Custom mode, clicking Import at the
bottom of the Color Editor window allows you to import a calibration target file (.trg)
created on another Fiery using the previous version of ColorWise. The current version
of ColorWise does not allow you to save a target separately; rather, it saves the target in
conjunction with an output profile.
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5. Select the colors you want to edit by turning colors off and on.

The eye icon to the left of each color indicates whether that color is visible on the
graph and will be affected by changes to the curves, brightness, and dot gain controls.
You can view and edit all four colors (cyan, magenta, yellow, and black) at once, or in
any combination. Working with only one or two colors at a time allows you to
fine-tune your adjustments. To turn off a color, click its Eye icon. In the following
example, cyan and magenta are visible and can be edited.

6. To adjust the dot gain value for simulating press output, click Dot Gain.

Dot Gain

(¥ North American
Gain 2t 50 % 0%

4 »
i~ European

G:afr st B0 % 019

Jail| »

G st40 % 019

Jail| »

Cancel

Choose either the North American or European standard. Use the sliders to adjust to
the desired Dot Gain:

* The range of values for North American at 50% input are from 0% to 50% gain

on output.

* The range of values for European at 40% input are from 0% to 59% gain on output;
the range of values for European at 80% input are from 0% to 20% gain on output.
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7.

If you use Dot Gain values, apply the settings first, so that the curves are deflected from
their straight-line positions. Then make edits to the new curves. When you adjust Dot
Gain values, all existing points on the curve are removed. A warning dialog box allows

you to cancel Dot Gain settings before they are applied.

Use the plus and minus buttons to adjust brightness.

Changes to the brightness are reflected in the curve(s).

To adjust the curves directly, click and drag points on the curve or enter numbers into
the input and output boxes.

The graph maps the input percentage to the output percentage. (These percentages
refer to the size of the CMYK halftone dots.) The curve you selected appears, and
points along the curve are marked so you can adjust them.

A curve with this shape
makes a color appear
lighter by reducing
density in the midtones.

Output ¥
I R R

R EEEEEE
Input %

A curve with this shape
makes a color appear
darker by adding density
in the midtones.

1 U m W e w A @@ m

Output %

N EEEEEE.
put%

A curve with this shape
increases contrast.

I R R

Output %

R EEEEEEE
Input %
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10.

NoTe: You should adjust points in this way only affer you have entered the Dot Gain
and Brightness values.

For greater precision, type percentages in the Input and Output fields or use the arrow
keys on the keyboard to adjust the curve. To use the arrow keys, you must first click the

curve to establish an anchor point that serves as a reference.

For an output profile, set maximum densities of the C, M, Y, and K channels.

Enter the maximum densities, called D-Max values, of individual colors for profiles
that support density settings. D-Max settings are not available when you edit
Simulation profiles in Master mode.

When you are finished, click Save and enter a name for the new profile.

The new custom profile is saved to the Fiery with the new name. If you edit one of the
press standard targets (for example, SWODP-Coated, DIC, or Euroscale), consider
including the original name as part of the new target name (for example, DIC-new) to
help you remember the source of the new target.

Note: Preset default profiles are locked and must be saved with a new name.

For Windows 2000/XP and Mac OS computers, custom profiles must be linked to one
of the 10 predefined custom profile names (Simulation-1 through Simulation-10 for
Simulation, or Output-1 through Output-10 for Output) to be accessible from the
printer driver. Create as many custom profiles as you want, but a maximum of 10 are
available from the printer driver at any one time. For information on linking custom
profiles to the predefined custom profile names, see “Defining profiles” on page 3-7. If
you are using the printer driver for Windows 9x/Me/NT computers, custom profiles
will appear in the driver window without being associated with a predefined

profile name.

If you set a custom profile as the default, you can access it from the printer driver
without linking it to one of the predefined custom names. Select Printer’s default from
the printer driver.
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TO EDIT A SIMULATION IN QuIcK, FuLL (Source GCR),
oR FuLL (Output GCR) MODE

1.

2.

Start ColorWise Pro Tools and click Color Editor.

Choose Simulation from the View menu, select the simulation profile to edit, and then
click Select.

Another method is to open the Profile Manager, select a simulation profile, and

click Edit.

Choose Quick, Full (Source GCR), or Full (Output GCR) from the Edit Mode menu, and
choose an output profile with which your edited simulation will be linked from the
Link with menu.

The edited simulation will be linked with the output profile you choose from the
“Link with” menu.

K3 Fiery Color Editor:SWOP-Coated (EFI) M=l
Edit Mode Link with
o Jauiek =] | =l
g T Cyan D-Max
e . & 118
B N Magenta D-Max
2 & [ [1.29
2 Vallow  D-Max
B k-3 IU.SQ
9 Black D-tax
R Il 1 50
H
§ - e Brightness - | +|
5 bl
@ = - Dot Gain.. |
o o0 @™ 3| oa o= 0 = W@ im
nputd —
Input Cutput
I I Add RErnYE
Curves
Test Print Impart Select Prafile Save. Done |
e

Note: When editing a simulation profile in Quick mode, clicking Import at the
bottom of the Color Editor window allows you to import a custom Quick Simulation
created on another Fiery using the previous version of ColorWise. The current
version of ColorWise does not allow you to save custom Quick or Full Simulations
independently; rather, they are saved as components of the same profile.
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4. Edit and save the simulation, as described in steps 5 through 10 of the procedure
starting on page 3-13.
For this new simulation to be automatically applied to a print job, the CMYK
Simulation, Simulation Method, and Output Profile settings must be the same as those
used when you edited the profile. If the Simulation Method is different or a different
output profile is selected, the Master simulation is applied.

NoTe: A Simulation Profile can have a custom Master and one or more custom links—
up to three links (Quick mode and the two Full modes) for each output profile on the
system. For the CMYK Simulation Profile option in the printer driver, note that if you
select a custom profile for which the output ink percentage is greater than 0 and the
input ink percentage is 0, the Use Master print option will have no effect.

Undoing simulation edits

You can undo the changes you made to simulations (master and linked) in the
following ways:

* If you have not yet saved your edits, click Done on the Color Editor menu bar and
do not save the changes.

* If you saved your edits under a new simulation name and want to delete all edits (in
Master, Quick, and Full modes) to the simulation, see page 3-7.

Adjusting gray balance

The AutoGray feature allows you to use the copier’s built-in scanner as a measurement
device for adjusting the gray balance of output profiles. Gray balance refers to the
quality of neutral gray tones in a profile. In many cases, gray tones may contain a
bluish or reddish color cast. AutoGray helps shift these tones back toward

neutral grays. If you are satisfied with the gray balance of the copier, you do not need
to use AutoGray.
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TO CORRECT THE GRAY BALANCE OF AN OUTPUT PROFILE

Jury

.

2.

10.

11.

On the Copier Control Panel, press the Access button (key icon).

Enter your password.

Select Confirm.

Choose System Settings>System Settings>Scan Mode Setting>Others.

For Color_space, select 1 (dRGB).

Choose Close until the System Settings screen appears and then choose Exit.
Start ColorWise Pro Tools (on your Mac 0S or Windows computer).

Choose Output from the View menu.

Select a profile to edit and click Select, or open the Profile Manager, select a profile,
and then click Edit.

2 Fiery Color Editor- [Profile name]

Edit Mode

— |Custom -

Magenta D-hax

el oty D-Mlax

Black D-Max

v Brightness -]
- Dot Gain |

a 0 I 3| @ =@ 0 =W W im

psipy AutoGray... |

Input CQutput

ID— I— ID— I— Add Remove

Curves

0 0 @ T @ 0 & 70 @ 30 1m

Outpit %

Test Print. Impart... Select Prafile.. Save... Dane |
=

Choose Custom from the Edit Mode menu.

Click AutoGray.
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12.

13.

If the output profile contains no edit points, continue to step 14.

If the output profile contains edit points from a previous AutoGray session, choose an
action from the following warning.

Warning: AutoGray Points E

This profile already contains AutoGray edit points.
"Refine” will recycle current edit paints
for more accurate gray halance.

"Mew” will rermove current edit points
and proceed with new edit points.

e | Cancel |

Refine reuses edits points from a previous session in an attempt to make them more
accurate. Refine is optional; use it only if the gray balance in your test document still
needs improvements after the first AutoGray session. If two Refine applications cannot
fix the situation, it is probably because your test document is not correctly addressing
the output profile, or because the output profile that you are editing does not
adequately describe the actual copier and printing conditions. Clicking Refine more
than twice is not recommended.

New starts a fresh AutoGray session by first removing all edit points from a previous
session. We recommend clicking New when you have applied Refine more than twice.
If the output profile contains edit points that were entered by a user, click Proceed to
remove the points and continue with the AutoGray adjustment.

Proceed starts a fresh AutoGray session by first removing all user edit points. This is
because AutoGray cannot modify user-entered points.

This profile contains user-defined edit points.

FProceeding with AutoGray will remave
all current edit paints.

Cancel |
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14.

15.

16.

17.

18.

19.

20.

21.

22.

23.

24.

25,

26.

27.

28.

29.

Click OK to confirm printing of the measurement page.
Retrieve the page from the copier.

Follow the directions in the dialog box for placing the Kodak Gray Scale strip and the
AutoGray measurement page on the copier glass, and click Continue.

Messages display the progress of the gray balance adjustment.
From the Copier Control Panel, select Menu > Scan > Job Template.

Choose the desired calibration template: AutoCal or ColorCal.

Do not use the screen to edit the Template Description or make any other changes.
Press the DocuColor 3535 Scan button (large green button).

When the adjustment is complete, click OK (in Color Editor).

Color Editor displays the adjusted output profile curve. New edit points have been
inserted by AutoGray to modify the gray balance, in much the same way an expert user
would have done manually.

To make edits to the output profile curve, click AutoGray again.

Choose Refine to fine-tune the curve, or New to acquire a new curve for editing.

For more information on these steps, see page 3-19.

On the Copier Control Panel, press the Access button.

Enter your password.

Select Confirm.

Choose System Settings > System Settings > Scan Mode Setting > Others.
For Color_space, select 0 (sRGB).

Select Close until the System Settings screen is displayed.

Select Exit.
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Checking edited profiles

To view a printed sample of a profile before you save it to the Fiery, print one of
the following:

* Comparison Page provided with ColorWise Pro Tools, which shows a comparison of
images and colored patches with and without edits

¢ User-defined CALIB.PS in the Hold queue

You can create a custom comparison page and save it as a PostScript or Encapsulated
PostScript (EPS) file called CALIB.PS. Print the file to the Hold queue of the Fiery
from your application, or download it to the Hold queue with Fiery Downloader (see
page 2-8).

TO CHECK A PROFILE
1. Click Test Print from the Color Editor window.

parison Page

per Size
LTRIA4 =l

[~ sample Image Page
{User-downloaded CALIB.PS in Hold Queus)

Print Cancel

2. Select a page to print.

3. Specify a paper size (Comparison Page only).

For a Comparison Page, choose LTR/A4 or 11x17/A3 from the Paper Size menu.

4. Click Print.



3-22 | ColorWise Pro Tools

Color Setup

Use Color Setup to set the default ColorWise settings for the Fiery. To access Color
Setup, click its icon in the ColorWise Pro Tools main window.

Setting default ColorWise options

Color Setup allows you to configure the default color management settings for the
Fiery. These settings are applied to all print jobs sent to the Fiery, unless a user
overrides them for an individual job by changing settings in the printer driver.

These default settings can also be overridden using Command WorkStation, Fiery
Spooler, or Fiery WebSpooler. Color Setup maintains a connection to the Fiery, so
changes made in Profile Manager appear automatically. In addition, the defaults set in
Color Setup are automatically reflected in other Fiery tools that list default settings.

To reset the Fiery to its factory default settings, click Factory Default in the lower-left
corner of the Color Setup window.

The options in Color Setup are arranged in a pattern representing the flow of color
p p g p p g
processing that takes place on the Fiery.

Color Setup M= =
These options will be used as the default for this printer.
RGH Source Profile Rendering Style
§ & |=[EFRGB | et [Presentation =l
ﬂRGE Separation
" Simulation @ Output
i
CMYK Simulation Profile
=
z — | 24YOP-Coated (EFI =
-] Output Profile
ChYK Simulation Stie  |Full (Output GCR) hd
Fiery Color Profile hd
Ed
g o [ =0t Color Matching
o
= |
&= —b|7 Blre ElzckEN extardiGraphice:
@
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For those color options that offer multiple choices, make your selection from the menu
that appears. For RGB Separation, select the radio button next to the option name. For
other options, select a check box next to the option name. Once you have made your
changes, you must click OK or Apply for the changes to take effect. Clicking OK sets
the new defaults and closes the Color Setup window. Clicking Apply sets the new
defaults and keeps the Color Setup window open. Clicking Cancel closes the Color
Setup window without applying any changes to the default settings.

For most users, the factory defaults result in optimal color output.






Appendix A:
Color
Measurement
Instruments

A-1 | Color Measurement Instruments

This appendix explains how to set up and calibrate the following color measurement
instruments, available as separately purchased options:

* X-Rite DTP41 automatic scanning spectrophotometer

* X-Rite DTP32 automatic scanning densitometer

Using the X-Rite DTP41 spectrophotometer

ColorWise Pro Tools Calibrator supports the X-Rite DTP41 spectrophotometer, a
device that measures density and color data. The DTP41 communicates directly with
the Calibrator application in ColorWise Pro Tools, sending measurements to the Fiery
automatically.

Setting up the DTP41

Before you calibrate the Fiery, you must connect, configure, and calibrate the
spectrophotometer to prepare for measuring the printed patches. For additional
information about setting up and using the DTP41, see the documentation included
with the instrument.
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To CONNECT THE X-RITE DTP41 TO THE COMPUTER
1. Turn off the computer.
2. Unpack the X-Rite DTP41 and remove the spacer from the measurement page slot.

3. Plug the square end of the interface cable (looks like a modular phone plug) into the
serial interface connection on the side of the X-Rite DTP41.

Instrument button

Alignment mark

LED indicator

Measurement page slot

Power input

Calibration strip entrance

Serial interface connection
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4. Attach the connector to the computer.

For a Windows computer, insert the 8-pin mini-DIN end of the interface cable into
the 9-pin DB9 Connector cable adapter. Insert the 9-pin end into the COM1 or
COM2 port on the computer and tighten the screws. If the available port on your
computer is 25-pin, you must use the 8-pin-to-25-pin adapter.

Unused connector Square connector

Connect to computer Interface cable

Connect to adapter

For a Mac OS computer, connect the 8-pin mini-DIN plug directly into the serial port
of the computer.

Unused connector

Connect to serial port
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Note: For Mac OS computers with a USB port (for example, an iMac), you need an
adapter to connect the DTP41 to your computer. For information on supported

adapters, see the X-Rite, Inc. web site (www.x-rite.com).

Use the AC adapter to provide power.

Plug the small connector on the adapter cable into the power input of the X-Rite
DTP41 and plug the AC adapter into the power cord. Plug the power cord into a
wall outlet.

AC adapter

6.

7.

8.

Power cord

Small connector

Turn on the computer.

Calibrate the X-Rite DTP41 using ColorWise Pro Tools (see the following section).

Calibrate the Fiery using ColorWise Pro Tools and the DTP41 (see page 2-10).
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Calibrating the DTP41

For the best color accuracy, calibrate the X-Rite DTP41 spectrophotometer every time
you calibrate the Fiery. You can initiate the calibration sequence in ColorWise Pro
Tools Calibrator as part of the process of Fiery calibration. The computer may also
prompt you that it is necessary to calibrate the spectrophotometer.

Alternatively, you can initiate the DTP41 calibration process using the Instrument
button on the DTP41. For more information on this method, see the documentation
that came with the X-Rite DTP41.

Multiple users can be connected to one Fiery with ColorWise Pro Tools, but only one
user at a time can use the Calibrator module. An error message appears if you try to
calibrate when another user is already using ColorWise Pro Tools to calibrate.

You will need the Color Reflection Reference strip that is included with the
spectrophotometer. Remove the strip from its protective envelope, handling it by the
edges only. Keep the strip free of dust and smudges and always store it in the protective
envelope.

To CALIBRATE THE X-RITE DTP41

1.

2.

3.

Connect the spectrophotometer to the computer and turn on power (see page A-2).

Start Calibrator.

For instructions on starting Calibrator, see page 2-6.

Choose DTP41 as the measurement method.
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4. 1In the Get Measurements pane, click Measure.

5. In the Measurement Options dialog box, click Measure.

Page Type
|21 Sarted Patches =l
Faper Size
|LTRiA4 =l

Cancel |

6. Choose the appropriate COM port for the DTP41 from the Available Ports menu.

The Instructions area displays instructions for selecting the port.

e DT
—Instructions Fatch Infa
Selectthe portthat DTP-41 is connected to 34 Sorted Patches
and press "Start Measurements” to scan the 1131 TIA3
patch page.

Available Ports
ICOM1 vl

Start Measurements

Utilities |
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7. Click Utilities.

The Utilities dialog box appears.

Instructions

Select"Calibrate DTP-41" to calibrate the
instrument using the Reference Strip.

Select"Show DTP-41 Info" to display
instrument version and serial numhbers.

Calibrate DTP-41 Showe DTP-41 Info

To view version and serial number information, click Show DTP-41 Info, and then
click Done.

8. Click Calibrate DTP-41.

The Instrument Calibration dialog box appears.

—Instructions

Take the Color Reflective Reference (number 09573 out of its protective
sleeve and center the designated end of the reference under the alignment
mark. Slowly insert the strip pastthe frant idler rallers until it comes to rest
against the rear rollers {approximately 3 inches). Push the Reference strip
firmly, then press "Read Reference”.

— Status

Read Reference

Port: COM1

(B =3
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10.

11.

12.

13.

If you have not already done so, remove the shipping spacer from the measurement
page slot.

Insert the end of the Color Reflection Reference strip into the calibration strip
entrance on the DTP41. Center the arrow on the strip below the alignment mark
(see the diagram on page A-2), and slide the strip into the DTP41 until you feel the
resistance of the feed mechanism.

Click Read Reference in the Instrument Calibration dialog box.

The DTP41 pulls the calibration strip through automatically.

A message appears in the Status area when the calibration is finished.
Click Done.

Close the Utilities window.
This completes DTP41 calibration.

When the DTP41 requires calibration, your computer prompts you. When the
prompt message appears, click Calibrate Now and follow the instructions, starting
with step 8 on page A-7.

After calibrating the DTP41, calibrate the Fiery (see page 2-10).

Using the X-Rite DTP32 densitometer

ColorWise Pro Tools are designed to work with the X-Rite DTP32 reflection
densitometer, which feeds color measurements to the Fiery automatically.

NoTe: Measurements from other densitometers can be input using a simple
ASCII file format (see Appendix B).
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Setting up the DTP32

Before you calibrate the Fiery using the X-Rite DTP32, you need to connect,
configure, and calibrate the densitometer to prepare for measuring the printed patches
(see “Calibrating the DTP32” on page A-11). For additional information about setting
up and using the DTP32, see the separate documentation included with the
densitometer.

To CONNECT THE X-RITE DTP32 TO THE COMPUTER

1.

2.

Turn off the computer.

Plug the square end of the interface cable (looks like a modular phone plug) into the
I/0 port on the side of the X-Rite DTP32.

Square connector

Attach the connector to the computer.

For a Windows computer, insert the 8-pin mini-DIN end of the interface cable into
the 9-pin DB9 Connector cable adapter. Insert the 9-pin end into the COM1 or
COM2 port on the computer and tighten the screws. If the available port on your
computer is 25-pin, you must use the 8-pin-to-25-pin adapter.

Unused connector

Connect to computer

Square connector

Connect to adapter

Interface cable
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For a Mac OS computer, connect the 8-pin mini-DIN plug directly into the serial port

of the computer.

Unused connector

Connect to serial port

Note: For Mac OS computers with a USB port (for example, an iMac), you need an
adapter to connect the DTP32 to your computer. For information on supported
adapters, see the X-Rite, Inc. web site (www.x-rite.com).

Plug the small connector on the adapter cable into the side of the X-Rite DTP32 and

Calibrate the DTP32 (see the following section).

4.,
plug the AC adapter into a wall outlet.
Small connector
AC adapter
5. Turn on the computer.
6.
7.

Calibrate the Fiery using ColorWise Pro Tools and the DTP32 (see page 2-15).
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Calibrating the DTP32

You will need the black-and-white X-Rite Auto-Cal Strip included with the
densitometer. Calibrating the densitometer does not require ColorWise Pro Tools.

To CALIBRATE THE X-RITE DTP32

1.

2.

Connect the densitometer to the computer and supply power (see page A-9).
From the main menu on the X-Rite DTP32 display, press the p1 key once to reach p2.

Press the cal key.

Calibrating motor speed is displayed, followed by the words INSERT CAL STRIP.

Insert the X-Rite Auto-Cal Strip into the 35mm slot on the front of the X-Rite DTP32—
arrow end first—until it stops or the densitometer starts pulling the strip.

Reading appears momentarily, followed by the density values and CALIBRATION OK.
The densitometer automatically returns to the MAIN MENU.

If UNRECOGNIZABLE STRIP appears, repeat the process or try cleaning the strip (see the
X-Rite DTP32 Operating Manual).
Start ColorWise Pro Tools and calibrate the Fiery.

Recalibrate the DTP32 at least once per month. For critical color, calibrate the
densitometer every time you calibrate the Fiery. The DTP32 may also warn
periodically that it requires calibration.
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B-1 | Importing Density Measurements

This appendix describes Simple ASCII File Format, which can be used to import
density measurements from measurement devices. To use your own measurement data
from an alternate measurement instrument, record your individual readings in a text
file and structure it as follows.

Simple ASCII Import File Format (SAIFF)

This format describes Status T measurement data for import into the ColorWise Pro
Tools Calibrator. The three possible file formats are:

* 1D Status T density for EFI 34 patch page
* 1D Status T density for EFI 21 patch page
* 1D Status T density for other pages (maximum of 256 patches per ink)

The file format is ASCII and has no tabs. A single space or multiple spaces are used
as delimiters. Blank lines are not allowed. Each line in the file represents four patches
(C, M, Y, K) of a specific ink value. Comments may be on any line in the file, and
these lines start with a pound sign (#) followed by a space. A line with a pound sign
followed by any character other than a space has been reserved. Comments must be

on an entire line by themselves.

Each line of data contains five values. The first number is the sequential patch number
(for EFI 34 and EFI 21 pages) or the ink value percentage (for other pages). The four
values that follow are the density values of C, M, Y, and K of the corresponding patch.
Lines are ordered either by increasing sequential patch numbers, or by increasing the
ink percentage.

For Windows computers, the file extension must be .cm1. For Mac OS computers, the

file type must be “TEXT".

Measurement data in EFI 34 and EFI 21 are paper-relative. For other pages, if the first
line corresponds to zero ink value, the Calibrator assumes that the measurement data is
absolute and adjusts it to become paper-relative by subtracting the density values of the
first line from the remaining patches.
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Example of 1D Status T density for EFI 34 patch page

This file format is used to specify the Status T density measurements of the EFI 34
patch page. The value in the first column is the patch number. The first patch must
be 1 and the last must be 34.

#!EFI 3

# EFI ColorWise 2.0 Data

type: 1DST34

# Cyan Magent Yellow Black

1 0.0300 0.0400 0.0200 0.0400
2 0.0600 0.0700 0.0800 0.0700
3 0.1000 0.1000 0.1000 0.1000
(..more data...)

33 1.6700 1.3400 0.8900 1.6700
34 1.7200 1.4300 0.9300 1.7500

Example of 1D Status T density for EFI 21 patch page

This file format is used to specify the Status T density measurements of the EFI 21
patch page. The value in the first column is the patch number. The first patch must
be 1 and the last must be 21.

#!EFI 3

# EFI ColorWise 2.0 Data

type: 1DST21

# Cyan Magent Yellow Black

1 0.0300 0.0400 0.0200 0.0400
2 0.0600 0.0700 0.0800 0.0700
3 0.1000 0.1000 0.1000 0.1000
(..more data...)

20 1.6700 1.3400 0.8900 1.6700
21 1.7200 1.4300 0.9300 1.7500
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Example of 1D Status T density for an arbitrary page

This file format is used to specify the Status T density measurements of a user-defined
patch page. The value in the first column is the ink/toner percentage of the patch. The
first percentage must be 0 and the last percentage must be 100. The percentages must
increase in between.

#!EFI 3

# EFI ColorWise 2.0 Data

type: 1DST

percnt Cyan Magent Yellow Black
.0000 0.0300 0.0400 0.0200 0.0400
.3922 0.0600 0.0700 0.0800 0.0700
.1765 0.1000 0.1000 0.1000 0.1000
(..more data...)

98.0000 1.6700 1.3400 0.8900 1.6700
100.0000 1.7200 1.4300 0.9300 1.7500
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Absolute Colorimetric rendering style 1-6

Apple Standard setting, RGB Source Profile
option 3-2

Apple Standard setting, RGB Source profile
option 1-7

AutoCal calibration 2-24

B

Black Detection option 1-5

Black Overprint option 1-4, 1-12

black text and line art 1-4, 1-11 to 1-13
Brightness option 1-3

C
CALIB.PS file 3-21
calibration
AutoCal 2-23 to 2-27
bypassing 1-4
checking status 2-5
ColorCal 2-23 to 2-27
Comparison Page 2-8
curves 2-3,2-9
DTP32 2-15
DTP41 2-11
ED-100 2-19
importing density measurements B-1 to
B-3
importing target file 3-12
measurement page 2-4
measurements 2-2
overview 2-2 to 2-5
patches 2-4
restoring defaults 2-10
scanner 2-25
scheduling 2-4
targets 2-2, 2-3
viewing measurements 2-9

Calibrator

Expert Mode 2-8

printing Comparison Page 2-8

restoring defaults 2-10

using 2-6 to 2-10

viewing measurements 2-9
CMYK Simulation Method

option 1-4, 1-10

CMYK Simulation Profile option 1-4, 1-9
Color Editor

AutoGray 3-18

dot gain adjustment 3-13

Edit Modes 3-11

importing calibration target 3-12

undoing simulation edits 3-17
color management system (CMS) xii
Color Mode option 1-3
color profiles, see ICC profiles
Color Reference pages 2-5
color rendering dictionary

(CRD) xiii, 1-3, 1-6, 1-17

color rendering styles, see rendering styles
color separations, see separations
Color Setup 3-22
color space 1-1, 1-3, 1-4
ColorCal calibration 2-24
ColorSync Color Matching option 1-18
ColorWise

key features xii, 3-22

print options 1-3 to 1-14, 3-22

workflow diagram 1-2
ColorWise Pro Tools

Calibrator 2-6 to 2-10

checking calibration status 2-5

Color Editor 3-10 to 3-21

Color Setup 3-22

Profile Manager 3-2 to 3-10
Combine Separations option 1-3, 1-5
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Comparison Page 2-8, 3-21

composites, printing 1-3, 1-5, 1-12, 1-14
Configuration page 2-5

Contrast ICC rendering style 1-6

custom simulations 1-9

D

default color controls set in Setup 1-3
densitometer
DTP32 2-15to 2-17, A-8 to A-11
ED-100 2-17 to 2-22
density values
about 2-3, 2-5
importing B-1 to B-3
DIC, CMYK Simulation option 3-2
dot gain values, adjusting 3-13
drivers, see printer drivers
DTP32
calibrating with 2-15
instrument calibration A-11
setup A-9
DTP41
calibrating with 2-11
instrument calibration A-5
setup A-2

E
ED-100 2-18 to 2-19
EFI Densitometer, see ED-100
EFI Spectrometer, see ES-1000
EFIRGB, RGB Source Profile
option 1-7, 3-2
ES-1000 2-17
Euroscale, CMYK Simulation option 3-2

F

Full (Output GCR) setting, CMYK
Simulation Method option 1-10

Full (Source GCR) setting, CMYK
Simulation Method option 1-10

G

Gamma option 1-3
Graphics ICC rendering style 1-6
gray balance, correcting 3-18

I
ICC profiles
backing up 3-6
default directory 3-4
defined xiii
defining 3-8
deleting 3-7
descriptions 3-2
downloading 3-4
editing 3-10 to 3-21
gray balance, correcting 3-18
rendering styles 1-6
setting defaults 3-3
Image ICC rendering style 1-6
Image Smoothing option 1-5

M

Mac OS color management
options
1-16 to 1-19

Match Copy setting of CMYK
Simulation option 1-4

measurements page 2-4

N
None setting, RGB Source
Profile option 1-8

0

Other setting, RGB Source
Profile option 1-7

Output Profile option 1-4, 1-10

output profiles, calibration sets

for 2-3, 2-4, 3-10
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P
PANTONE Coated Color
Reference 1-14
passwords
for calibration 2-2, 2-6
for profile management 3-2
patches page 2-4
Perceptual ICC rendering style 1-6
Phosphors option 1-3
Photographic rendering style 1-6
PostScript color issues
1-2,1-8, 1-12, 1-13
PostScript Color Management 1-17
PostScript Color Matching
option 1-17
PPD 1-15, 1-17
Presentation rendering style 1-6
Print Mode option 1-3
print options
about 1-3 to 1-14
Mac OS 1-16to 1-19
setting defaults 3-22
Windows 1-15 to 1-16
printer drivers
Mac OS 1-16to 1-19

two-way communication

1-7,1-9, 1-11
Windows 1-15 to 1-16
Profile Manager

backing up profiles 3-6
defining profiles 3-8
deleting profiles 3-7
downloading profiles 3-4
setting defaults 3-3
profiles, see ICC profiles
Pure Black Text/Graphics
option 1-4, 1-11

Q

Quick setting, CMYK Simulation
Method option 1-10

R

Relative Colorimetric rendering style 1-6

Rendering Style option 1-3

rendering styles xiii, 1-2, 1-3, 1-6

RGB images
defining source profiles for 1-7, 3-2
PostScript and non-PostScript

conversion 1-8
RGB Separation option 1-4, 1-8
RGB Source Profile option 1-2, 1-3, 1-7

S

SAIFF format B-1 to B-3

Saturation ICC rendering style 1-6

scanner, calibrating 2-25

Screen Switching option 1-5

separations

printing 1-3, 1-5, 1-12, 1-14
target color space 1-4, 1-8

Setup, default color controls set in 1-3

Sharpness option 1-5

simulations, custom 1-9

Source 1-10 setting, RGB Source Profile
option 1-7

spectrometer, see spectrophotometer

spectrophotometer, DTP41 2-10 to
2-14, A-1 to A-8

Spot Color Matching option 1-5, 1-13

spot colors, matching to CMYK
equivalents 1-13

sRGB, RGB Source Profile option 1-7, 3-2

Status T B-1

SWOP setting, CMYK Simulation Profile
option 1-9, 3-2
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T

targets, for calibration 2-3

Test Page 2-5

Text and Graphics Enhancement option 1-5
transfer functions 2-3

two-way communication 1-7, 1-9, 1-11

U
undercolor removal (UCR) 1-8

w

White Point option 1-4

Windows color management options
1-15 to 1-16
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